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Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and workmanship
for a period of one (1) year from the date of shipment. If a product proves defective during this warranty period, Tektronix,
at its option, either will repair the defective product without charge for parts and labor, or will provide a replacement in
exchange for the defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the
warranty period and make suitable arrangements for the performance of service. Customer shall be responsible for
packaging and shipping the defective product to the service center designated by Tektronix, with shipping charges prepaid.
Tektronix shall pay for the return of the product to Customer if the shipment is to a location within the country in which the
Tektronix service center is located. Customer shall be responsible for paying all shipping charges, duties, taxes, and any
other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting
from attempts by personnel other than Tektronix representatives to install, repair or service the product; b) to repair
damage resulting from improper use or connection to incompatible equipment; c) to repair any damage or malfunction
caused by the use of non-Tektronix supplies; or d) to service a product that has been modified or integrated with other
products when the effect of such modification or integration increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR
IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’ RESPONSIBILITY TO
REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO
THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE
LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE
OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.
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Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it. To avoid potential hazards, use this
product only as specified.

Only qualified personnel should perform service procedures.

�&� �%#$�% �#*�% �#%�� Use only the power cord specified for this product and
certified for the country of use.

�#""��' �"� ��&�#""��' �%#$�% ,� Do not connect or disconnect probes or test
leads while they are connected to a voltage source.

	%#("� '�� �%#�(�'� This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

��&�%)� �  ��%!�"� ��'�"�&� To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

�# #' �$�%�'� ��'�#(' �#)�%&� Do not operate this product with covers or panels
removed.

�)#�� �+$#&�� ��%�(�'%,� Do not touch exposed connections and components
when power is present.

�# #' �$�%�'� ��'� �(&$��'�� ��� (%�&� If you suspect there is damage to this
product, have it inspected by qualified service personnel.

�# #' �$�%�'� �" ��'���!$ �#"��'�#"&�

�# #' �$�%�'� �" �" �+$ #&�)� �'!#&$��%��

���$ �%#�(�' �(%����& � ��" �"� �%,�

�%#)��� �%#$�% ��"'� �'�#"� Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

��%!& �" '��& ��"(� � These terms may appear in this manual:

�������� Warning statements identify conditions or practices that could result
in injury or loss of life.

�# �)#�� ��%� #%
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�������� Caution statements identify conditions or practices that could result in
damage to this product or other property.

�	�� �� �
	 �������� These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

������ �� �
	 �������� The following symbols may appear on the product:
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The user manual for the MTG100 and MTG300 MPEG Generator contains the
following sections:

Getting Started briefly describes the MTG100 and MTG300 MPEG Generator
and provides installation instructions, options listing, accessories listing,
repacking instructions, and power on and off instructions.

Operating Basics provides an overview of the front panel controls and rear panel
connections, operating principles, basic operating procedures, and numeric input
methods. This section also provides examples of basic data outputting.

Reference provides detailed information about the functions and use of the
MTG100 and MTG300 MPEG Generator’s main menus.

Appendices provides product specifications, instructions for operating the
MTG Comm+ file transfer application and ReMux application, performance
verification procedures, and instructions for inspecting and cleaning the MPEG
generator.

�	��

This manual uses the following terms:

� Stream: Generic term for transport streams and data streams of Non TS
format (i.e.,data format other than transport stream format).

� S-TMCC (Single TMCC): Transport stream to which TMCC (Transmission
and Multiplexing Configuration Control) information is inserted into the 8
bytes in its Reed-Solomon code area (16 bytes). It is defined in the ISDB-S
(Integrated Services Digital Broadcasting-Satellite) system.

� M-TMCC (Multi TMCC): Transport stream to which TMCC information is
inserted into the sync byte area, and having super frame structure. It is
defined in the ISDB-S system.

�	���	� �������

The following related documentation for the instrument is available:

� The MTG100 & MTG300 MPEG Generator Service Manual (Tektronix part
number 071-0616-XX) describes how to maintain and service the MTG100
and MTG300 MPEG Generators and provides a complete module-level
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description of the operation of the instrument. This manual is an optional
accessory.
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This section provides the following information:

� Product description

� List of standard and optional accessories

� List of instrument options

� Initial product inspection procedure

� Installation instructions

� Instructions for repackaging the instrument for shipment

� Functional check procedure

���	��� �
��������

The MTG100 and MTG300 MPEG Generators store and playback MPEG-2
transport streams that are compliant with ATSC, DVB, and ARIB standards. The
MPEG generators can automatically update the time stamp values of the
transport stream in real time to support long term playout. Table 1-1 lists the
main features of the MPEG generators.

You can output transport streams stored in the MPEG generators to perform the
following tasks:

� Evaluate IRD/STB designs and manufacturing processes

� Evaluate performance of MPEG-2 equipment

� Perform conformance testing of MPEG-2 systems

� Provide substitute signal generation for digital television transmitters

The MTG300 MPEG Generator facilitates complete stress testing by providing
comprehensive capabilities to customize stored transport streams. In addition, the
MTG300 MPEG Generator allows you to effectively monitor receiver operation
by inserting PSI/SI/PSIP tables into the transport stream.
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�������� The MPEG generator comes from the factory with sample transport
stream files loaded on the hard drives. To prevent the loss of these files, it is
recommended that you use the MTG Comm+ application to save copies of these
files. Refer to Appendix B: Using MTG Comm+ for File Transfers.
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Table 1-2 lists the standard and optional accessories provided with the MTG100
and MTG300 MPEG Generators.
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Table 1-3 lists the instrument options that can be ordered with the MPEG
generators. Table 1-4 lists the available power cord options.

���� �����	��������� ��������


����� ������ �����������

�

��%/-&4%6-21 �)56��%6% �)3246�

",)1 ;27 24()4 �36-21 �
� % 4)3246 9-6, 6,) '%/-&4%6-21
6)56 (%6% *24 6,) -156470)16 9-// &) 3428-()( 9-6, ;274
���� +)1)4%624�


�
��%'.02716-1+�

",)1 ;27 24()4 �36-21 
�� 6,) ���� +)1)4%624 -5
5,-33)( '21*-+74)( *24 02716-1+ -1 % 
�<-1', 4%'.�

$27 '%1 -156%// % 4%'.02716-1+ .-6 �236-21%/ %'')5524;� -*
;27 1))( 62 '21*-+74) % 56%1(%4( ���� +)1)4%624 *24
02716-1+ -1 % 
�<-1', 4%'.� �)*)4 62 �%&/) 
<� *24 6,)
�).6421-: 3%46 170&)4 2* 6,) 4%'.02716-1+ .-6�



Getting Started

��� MTG100 & MTG300 MPEG Generator User Manual

��
�
�� ������ ����	��
�

Perform the following product inspection procedure when you initially receive
your instrument:

1. Inspect the MPEG generator shipping carton for external damage, which
indicates possible damage to the instrument.

2. Remove the MPEG generator from the shipping carton, and then check that
the instrument has not been damaged in transit. Prior to shipment the
instrument is thoroughly inspected for mechanical defects. The exterior
should not have any scratches or impact marks.

����. Save the shipping carton and packaging materials for instrument
repackaging in case shipment becomes necessary.

3. Verify that the shipping carton contains the basic instrument, the standard
accessories listed in Table 1-2, and any optional accessories that you ordered.

4. After you install the MPEG generator (refer to Installation on page 1-6),
you can perform the performance verification procedure in Appendix D:
Performance Verification if you want to verify that the instrument performs
to the specifications listed in Appendix A: Specifications.

Contact your local Tektronix Field Office or representative if there is a problem
with your instrument or if your shipment is incomplete.
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Before you install the instrument, refer to the General Safety Summary at the
front of this manual for power source, grounding, and other safety information.

Verify that the location of your installation has the proper operating environment.

��
	���� Damage to the instrument can occur if this instrument is powered on
at temperatures outside the specified temperature range.

The MPEG generators operate correctly in ambient temperatures from +5� C to
+40� C and in relative humidity from 20% to 80%. For complete operating
environment information, refer to Appendix A: Specifications.

Verify that there is at least 5.0 cm (2 inches) of clearance on top and bottom,
15.0 cm (6 inches) on the left and right sides, and 7.5 cm (3 inches) at the rear of
the instrument to allow for heat dissipation. Verify that the air intake holes on the
sides and bottom of the cabinet are not obstructed.

��	�. If you are installing the instrument in a dedicated rack, refer to the
instruction sheet that comes with the rackmounting kit for proper installation
procedures.

When the generator is mounted in a 19-inch rack, verify that there is at least one
unit of clearance above the MPEG generator.

Check that your location provides the proper electrical power requirements as
listed in Table 1-5.
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Refer to Table 1-4 on page 1-5 to verify that you are using the proper power
cord for your location. Connect the power cord from the rear-panel power
connector to the power system.

��
	���� The instrument is shipped with a power cord appropriate for use with
your power systems (normal 115 V power system or 230 V power system). If the
instrument is to be used with a power system other than what the order specified,
the power cord must be replaced with one appropriate for the power source
used. Refer to Table 1-4 for a listing of available power cords.

After you have verified the environment, AC line, and power cord requirements,
apply power to the instrument by plugging the power cord into the power
connector on the rear panel (see Figure 1-1), and then plugging the power cord
into the local power source.

	���� ��������� The MPEG generator uses two power switches: the Principle
Power Switch (located on the rear panel) and the ON/STBY switch (located on
the front panel).

When the Principle Power Switch is in the on position (see Figure 1-1), power is
applied to the power supply standby circuit of the instrument. After the Principle
Power Switch is on, use the front-panel ON/STBY switch (see Figure 1-2) to
apply power to the rest of the instrument.

��	�. After the instrument is installed, it is recommended that you leave the
Principal Power Switch in the on position and use the ON/STBY switch as the
power switch.

	���� ��� After you power on the instrument, verify that the fan is operating.

��
	���� Do not operate the instrument if the cooling fan does not operate
when you turn the instrument on. Serious damage to your instrument can occur
from overheating if the cooling fan is not operating.

��	�. Allow the instrument to warm up for 20 minutes prior to calibrating the
clock or making precision measurements. The instrument must be completely
warmed up to operate at its optimum precision.

	���� ��� 
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The MPEG generator automatically runs diagnostics when the instrument is
powered on using the ON/STBY switch. These diagnostics check that the
instrument is performing within its defined operating characteristics. If all of the
diagnostic checks are completed without any errors, the instrument displays the
menu bar and status bar.

����. If the instrument chassis temperature is outside the specified operating
range, an error will occur during the power-up diagnostics. If this happens,
power off the instrument, wait until the chassis temperature is within normal
operating range, and then power on the instrument again.

If a diagnostic error is displayed during instrument start up, contact your local
Tektronix Field Office or representative.

�
��	������ ��� ����
��

When you ship this instrument, use the original packaging material if possible.
If the original packaging is unfit for use or is not available, repackage the
instrument using the following procedure:

1. Obtain a corrugated cardboard shipping carton having inside dimensions at
least six inches greater than the instrument dimensions and having a carton
test strength of at least 125 kg (275 pounds).

2. If the instrument is being shipped to a Tektronix Service Center for repair or
calibration, attach a tag to the instrument showing the following information:

� The owner of the instrument (with address).

� The name of a person at your firm who may be contacted if additional
information is needed.

� The complete instrument type and serial number.

� A description of the service required.

3. Wrap the instrument with polyethylene sheeting or equivalent to protect the
outside finish and prevent entry of packing materials into the instrument.

4. Cushion the instrument on all sides by tightly packing dunnage or urethane
foam between the carton and the instrument, allowing for three inches
(7.62 cm) of padding on each side (including top and bottom).

5. Seal the carton with shipping tape or with an industrial stapler.

6. Mark the address of the Tektronix Service Center and your return address on
the carton in one or more prominent locations.

�������� ���������	�



Getting Started

���� MTG100 & MTG300 MPEG Generator User Manual

��������� ���� ��������

Perform the following procedure if you are operating the instrument for the first
time (to verify that the instrument shipped without damage) or you suspect that
the instrument is not working properly:

����. Before you perform this procedure, install the MPEG generator following
the instructions listed in Installation starting on page 1-6.

1. Connect the MPEG generator to a power source, and then turn the instru-
ment on using the power switches.

2. Press the front-panel MENU  button to enable the pull-down menu display.
When the pull-down menus are enabled, the name of the selected pull-down
menu is highlighted.

3. Use the left and right arrow buttons to select the FILE  pull-down menu.

4. Use the rotary knob or the arrow buttons to select Open TS File... from the
menu, and then press the OK  bezel button to open the dialog box shown in
Figure 1-3.

5. Use the rotary knob or the arrow buttons to select the test64.trp file, and
then press the OK  bezel button. The hierarchy view of the transport stream
file will be displayed on the screen.

������ �����	���� 
	 ���� ������ ���
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6. Connect a 75 � cable between the ASI OUT  connector on the MPEG
generator rear panel to the ASI IN  connector on an MPEG decoder. See
Figure 1-4.

7. Connect the decoder to a picture monitor.

8. Press the MPEG generator START/STOP button to start the transport
stream output. When transport stream output is started, the Output Status
indicator in the status bar changes from Stopped to Running.

����. You can select the test40.trp file in step 5 of this procedure if you need to
decrease the bit rate of the transport stream due to performance restrictions in
your decoder.

9. Check that the picture from the transport stream is displayed correctly on the
picture monitor.
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This section introduces you to the basics of operating the MTG100 and MTG300
MPEG Generators. The information is divided into the following subsections:

� Functional Overview contains descriptions of the front-panel controls, the
rear-panel connectors and power switch, and elements of the display.

� Using the Menu System provides the basic concepts of how to operate the
MPEG generator using the menus and front-panel controls, and how to enter
numeric or text input into dialog boxes.

� Output Loop Modes describes the loop modes that control the types of
changes the MTG100 and MTG300 MPEG Generators can make to
transport streams.

� Tutorials contains procedures that show you how to output and edit transport
stream data.

	��������� ������� 

This subsection contains descriptions of the front-panel controls, LCD display,
and the rear-panel connectors and power switch.

Figure 2-1 shows the locations of the front panel controls. Descriptions of the
front-panel controls appear on the following pages.

�
"�"��� �� ��  ����� Use the ON/STBY power switch as the standard power
switch during normal instrument operation instead of the rear-panel Principle
Power Switch. The Principal Power Switch must be in the On position before the
ON/STBY power switch will operate.

	����! ���� ������ Use the floppy disk drive to save and load a insertion file or
preset file. This drive accepts preformatted 2HD 3.5 inch floppy disks.

����. If you power on the instrument with a floppy disk inserted into the disk
drive, the system can not boot and no information appears on the screen. If this
happens, eject the floppy disk from the disk drive, and turn off the instrument
and then turn it on again.

	���� ����� ��������
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�
� �� ���#� The LCD display uses its 640 x 480 pixel resolution to display
transport stream components and the menu systems. Refer to LCD Display
Elements on page 2-6 for more information about the display.

	�$�� 	"!!�� � Use the bezel buttons to access various functions in conjunction
with the menu system on the LCD display.
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���" 	"!!��� This button works in conjunction with the menu system on the
LCD display. Press the MENU button to toggle the display between the
pull-down menus and the Icon cursor. When the pull-down menus are enabled,
the Icon cursor is disabled. When the Icon cursor is enabled, the pull-down
menus are disabled.

�!��!%�%�!�� 	"!!��� Press this button to start or stop transport stream output. The
Output Status indicator in the Status bar displays Running or Stopped to indicate
the current status of the output. The Buffer indicator in the Status bar lights when
data is being output.

��� ������!�� � The four LEDs indicate the following instrument conditions:

� The PLL indicator lights when the internal phase-lock loop is locked, which
indicates a correctly timed transport stream output. The indicator will turn



Operating Basics

MTG100 & MTG300 MPEG Generator User Manual �%�

off if the reference clock frequency shifts outside of the ranges listed in
Table 2-1.

� The BUFFER indicator lights when output data is being transferred from the
hard disk to the buffer.

� The EXT indicator lights when an external reference clock signal is input to
the rear-panel EXT 27MHz REFERENCE IN connector.

� The HDD indicator lights when the hard disk drive is in operation.

����� �%����� ������!�  ��� ���� ����� � ��"���$  �����
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	�#�������� 
�$���� Use the hexadecimal keypad to enter values in numeric or
character input modes. The characters A to F are primarily used for hexadecimal
input; instructions are displayed when these keys are used for other operations.
The BS (back space) key deletes previously input digits during numeric input or
deletes the character directly in front of the cursor during character input. The
Enter key confirms numeric and character input.

���! ���! �� �"!!��� The left control button performs the following functions on
the LCD display:

� When the Icon cursor is displayed in the hierarchy display, use this button to
toggle the display of any hierarchy items under the currently selected
hierarchy item on and off (expand or collapse the hierarchy).

� When a pull-down menu is displayed, use this button to select the high-
lighted menu item or to toggle the setting of the highlighted menu item on
and off.

����! ���! �� �"!!��� The right control button performs the following functions
on the LCD display:

� When the Icon cursor is displayed in the hierarchy display, use this button to
toggle the display of any hierarchy items under the currently selected
hierarchy item on and off (expand or collapse the hierarchy).
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� When the pull-down menus are enabled, press this button to quit the menu
operation.

�����" ����� When the knob icon appears on the display next to an item, the
rotary knob controls that item. Use the rotary knob to control the following
functions on the LCD display:

� In the hierarchy display, use this knob to move the Icon cursor between
hierarchy items.

� When a pull-down menu is displayed, use this knob to move between the
menu items.

� When a dialog box appears, use this knob to adjust numeric values.

����! � ������ Use the arrow buttons around the rotary knob to maneuver on the
LCD display. For example, you can use these buttons to move the Icon cursor or
to move among the pull-down menu selections.

Figure 2-2 shows the locations of the MPEG generator rear-panel connectors and
the power switch.
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�� �"!%$" � Use this 9-pin D-sub connector to input external ECL control
signals to the MPEG generator.


��*�*���*�*��	� �&%� Use this 25-pin D-sub connector to output an ECL, TTL,
or LVDS signal in parallel or serial formats.


�� ����) ����$�!�� !� Use this BNC connector to input an external 27 MHz
reference clock signal to the MPEG generator.

��	����� External clock signals with voltages in excess of 1 Vp-p can damage
the instrument. Only apply signals with voltages less than 1 Vp-p to the
EXT 27MHz REFERENCE IN connector.

�� �&%� Use this BNC connector to output an ASI signal.

�� �&%� Use this BNC connector to output an SSI signal.

��(�"�$�� Use this connector to attach a standard 101-key PC keyboard only
when service is being performed on the instrument.


%��$!�%� Use this connector to connect to your local Ethernet network.

����. Be sure to connect the MPEG generator to your local Ethernet network
before you power on the instrument. If not so, the instrument cannot connect to
the network.

��$�� � This 9-pin D-sub connector provides a serial interface for instrument
calibration.

���� Use this 9-pin D-sub connector to output the instrument display to a VGA
monitor, projector, or video printer (to make a screen hardcopy).

�$�!��# � �"'�$ �'�%��� Use this switch to apply power to the instrument standby
circuit. This switch must be in the On position before you can use the front-panel
ON/STBY switch to apply power to the rest of the instrument.
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�� ��� Use this power connector to apply power to the instrument using the
supplied power cord.

Figure 2-3 shows the location of the LCD display elements. These elements are
described starting below.

���� ���� The Menu bar displays the names of the four pull-down menus: FILE,
OUTPUT, CONFIG, and UTILITY. Press the Menu button to enable or disable
the pull-down menus. When the pull-down menus are enabled, the currently
selected menu name is highlighted. Use the Arrow buttons to select the desired
menu.


�������! ������!� Each icon in the hierarchy display represents an element of the
stream. The hierarchy text contains a description of the associated icon.

Refer to Hierarchy Display on page 3-25 for detailed information about the
hierarchy icons and their associated Bezel menu selections.

���� ������� The Icon cursor appears as a red box around an icon in the hierarchy
to indicate the currently selected icon. In most instances, generator functions
selected through the menus are applied to the selected hierarchy icon (represent-
ing a particular transport stream element).

Use the rotary knob or the arrow buttons to move the Icon cursor between icons.
When the Icon cursor is at the top or bottom of the hierarchy display, the
hierarchy scrolls to show additional elements of the stream when applicable.

	������ ���� �� ���������� ���� ������!� This box displays the elapsed time of
the current stream data output. When a TDT (Time and Data Table), TOT (Time
Offset Table), or STT (System Time Table) is contained in the transport stream,
the elapsed time since the initial time described in the table is displayed in this
box.

��"�� ����� The Bezel menu contains commands and functions that apply to the
hierarchy icon selected by the Icon cursor. The commands and functions
available in the Bezel menu depend on the type of transport stream element that
is selected.

������ ���� The scroll bar appears when there is a hierarchy display to show your
relative position in the hierarchy of the transport stream.

������! 	�������
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��� ���� ����� Press the Menu button to toggle the pull-down menu display for
the selected menu on and off. The contents of the menu depends on the type of
the selected hierarchy icon.
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���� ����� The knob icon appears adjacent to items on the display to indicate
that the rotary knob controls that item. For example, when the knob icon appears
next to a menu (as shown in Figure 2-3), you can use the knob to move through
the menu items. When the knob icon appears in a dialog box adjacent to a
highlighted parameter value, you can use the knob to adjust that value.

������ ���� The Status bar (see Figure 2-4) contains several indicators that
display general information about the transport stream output status.

� � � � � � 	

����� ����������� ���

The Status bar shows the following information:

1. Standard. This indicator displays the standard of the selected stream.
(MPEG2, ARIB, DVB, ATSC, S-TMCC, M-TMCC, or Non TS).

2. Loop Mode. This indicator displays which loop mode is being used for the
stream output (No Update, Auto Update, or Stress). Refer to Output Loop
Modes on page 2-15 for more information.

3. Packet Size. This indicator displays the packet length in bytes (188, 204,
208, or Non TS) of the stream output.

4. Clock Source. This indicator displays the source of the reference clock
(internal or external) used for the stream output.

5. Bit Rate. This indicator displays the bit-rate (in Mbps) of the stream output.

6. Position. This indicator displays the status of the stream output using time
and a duration gauge. The time indicates the stream time elapsed since the
beginning of the stream. The value is reset every time after the stream file
generation is complete. The duration gauge shows the progress of stream
generation. 

The duration gauge is updated every 1 second. If you output the stream with
repetition rate of 3 seconds, the gauge may not be displayed correctly.

7. Output Status. This indicator displays the current status (Running or
Stopped) of the stream output.



Operating Basics

MTG100 & MTG300 MPEG Generator User Manual � �

���� ��� 
��� ������

This section describes the basics of using the MPEG generator’s menu system
and the methods for entering numeric and text input in the various dialog boxes.

The menu system on the MPEG generator provides access to instrument settings
and to operational functions such as the selection of transport stream output
parameters. The menu system is comprised of two types of menus: the four
pull-down menus displayed in the Menu bar and the Bezel menu which is
displayed at the right side of the screen (see Figure 2-3 on page 2-7).

The pull-down menus are displayed in the Menu bar at the top of the screen. You
can operate these menus using the front panel MENU button, the right and left
control buttons, the arrow buttons, and the rotary knob (see Figure 2-5).

��������� ���� ���� 
��� ��������� The MENU button toggles display
control between the Icon cursor (used to select icons in the hierarchy display)
and the pull-down menus. When the Icon cursor is enabled (displayed), press the
MENU button to enable the pull-down menus. When the pull-down menus are
enabled or displayed, press the MENU button to close any open pull-down menu
and to enable (display) the Icon cursor.

When the pull-down menus are enabled, the Icon cursor is not displayed and the
currently selected pull-down menu name is highlighted in the Menu bar. Use the
left and right arrow buttons to select (highlight) the desired pull-down menu
(see Figure 2-6).
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When a pull-down menu is displayed, the knob icon is displayed at the upper-
right side of the command list. The knob icon represents the capability of the
rotary knob to move the highlighting (selecting) bar through the command list.
You can also move through the command list using the up and down arrow
buttons. Press the left control button or the OK bezel button to execute the
highlighted command.

	�����! ������ �� ��� ���"���� ���� ��������� The pull-down menu commands
can have the following two display states as shown in Figure 2-7:

� A command followed by “...” represents that a corresponding dialog box will
open after you execute the command.

� A command preceded by a check mark (�) represents the selected command
in a command list subsection. You can select only one command at a time in
a subsection, which is represented by a separation line in the command list.
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The Bezel menu displays a variety of commands. The commands change to
correspond to the transport stream item selected by the Icon cursor in the
hierarchy display, or to correspond to functions in a displayed dialog box.

��������� 	�"�� ��� 
�������� The Bezel menu appears at the right side of
the screen. When you move the Icon cursor through the hierarchy items in the
display, the Bezel menu commands change to correspond with the selected
transport stream item. Select the desired Bezel menu command by pressing the
associated bezel button (see Figure 2-8).

�
�
�
�������

������ �#�������� ����� ��� ��� ��� 	�"�� ���� ��������

������! ������ �� ��� 	�"�� ��� 
�������� The Bezel menu commands can
have the following three display states as shown in Table 2-2:

	�"�� ���
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��������  �� ������� �� ��&�� �!  �� #��� �$��! �  �� ������%��
�!�� ��� ������� ��%�

��������  �� ������� �� ��&�� �!  �� #��� ������%  �� �������������
������ ��$� � ���! ������� �����#�� �% '���� �������� �  �� �
������������� ������ ��$ #��� ���� �� �� %�! �$��! �  �� ��������

��������  �� ������� �� ��&�� �!  �� #���  �����  �� ����� �� � � � ��
 �� �!�� ���� 	�  ��� �$������  �� �������� ��� �������� �  ��  ��
���� � ����� �!�� ��� �� ��  � 	��� �"�� ��� �!�� ��� #���  �����  �
�� �"� �� %�! �����  �� ������� �� ��&�� �!  ���

You can enter numeric values in displayed dialog boxes by using the hexadeci-
mal keypad or by using the rotary knob.

�#�� �� ���#" �!��� "�� 
�$�������� ��%���� Perform the following procedure to
input numeric values. Figure 2-9 shows the hexadecimal keypad.

1. Select the numeric parameter you want to change in an open dialog box.

2. Input the desired parameter value using the numeric keys on the keypad, and
then press the keypad ENTER key.

3. Press the Apply  or OK  bezel button associated with the dialog box for your
value changes to take effect.

�
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�!����� 
��! �����  �� � ��$ ����� The knob icon is displayed next to a
selected dialog box parameter when you can use the rotary knob to change the
parameter value. Figure 2-10 shows a dialog box that can use the rotary knob to
enter numeric values.

You can use the rotary knob to change the value of the numeric digit indicated by
the underscore character. Use the arrow buttons to select any digit value to
change with the knob. Rotating the knob to the left decreases the value and
rotating it to the right increases the value.

You do not need to use the front panel ENTER key to confirm a value when
using the rotary knob to change a value. The input value is confirmed automati-
cally without pressing the ENTER key.

���� 
����������� �	�����
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Perform the following procedure to change a value using the rotary knob:

1. Select the numeric parameter you want to change in an open dialog box.

2. Use the left and right arrow buttons to move the underscore character to the
digit value you want to modify.

3. Change the value by turning the rotary knob.

Text input is required to enter the names for new folders and for entering text for
other dialog box parameters. When text input is required, the MPEG generator
automatically brings up a dialog box such as the one shown in Figure 2-11.

Perform the following procedure to enter text input:

1. Use the rotary knob to highlight the desired character in the letter/digit
matrix, and then press the front-panel ENTER button enter the character in
the text box.

2. Continue as in step 1 until the name is entered in the text box. Use the
front-panel BS (back space) key to erase incorrect input. The position where
the character will be inserted is indicated with an input cursor ( | ). Use the
left and right arrow buttons to change the position of the input cursor.

��# 
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3. Enter all of the desired characters then press the OK  bezel button to
complete the text entering process. Press the Cancel bezel button to cancel
text input and return to the previous display.

����� ������������ ��� ��� ��� �����

You can also use any file name listed in the Filename box instead of entering all
of the characters for a new file name.

Perform the following procedure to use the file name for entering a new file
name:

1. Press the down arrow button to highlight the Filename box. The knob icon
appears at the upper-right side of the box.

2. Use the rotary knob to select the file name that you want to use for entering a
new file name, and then press the front-panel ENTER button. The selected
file name appears in the text box.

3. Press the up arrow button to highlight the text box and letter/digit matrix.
The knob icon appears above the upper-right corner of the letter/digit matrix.

4. Edit the file name.

The MPEG generator displays a pop-up message box that prompts you to
confirm operations that will be difficult to recover from. An example of a pop-up
message box is shown in Figure 2-12, which shows the message box for
confirming that you want to defragment the TS drive. Press the OK  bezel button
to execute the operation displayed in the box. Press the Cancel bezel button to
cancel the operation and return to the state prior to selecting the menu command
that displayed the message box.
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The MPEG generator continuously outputs a transport stream using one of three
user-selected looping methods: No Update, Auto Update, or Stress (MTG300
only). You can set the output loop mode using the Configure pull-down menu.

����. For the transport stream packet with the transport_scrambling_control
value of 0, the PTS and DTS values are not updated even if the output loop mode
is set to Auto Update or Stress. When you playout the transport stream
scrambled by a decoder, be sure to use the No Update loop mode.

When the TDT/TOT/STT Update command from the Configure pull-down menu
is set to OFF, the timing values of the TDT/TOT/STT are not updated even if the
output loop mode is set to Auto Update or Stress. In this case, the elapsed time
of the current transport stream data output is displayed in the Elapsed Time or
TDT/TOT/STT Time Display box.

When the TOT is not held in one transport stream packet,  the CRC (Cyclic
redundancy Check) value in the table is not updated.

When the PTS/DTS information is not held in one transport stream packet with
the payload_unit_start_indicator value of 1, they are not updated correctly.

For the file downloaded in M-TMCC or Non TS format, you cannot select the
loop modes other than No Update. In addition, for the file downloaded in
S-TMCC format, you cannot select the Stress loop mode.

In the No Update loop mode, the MPEG generator outputs the stream with no
changes allowed (except setting the start packet and stop packet of the transport
stream). Time information values are not updated. You cannot make any changes
to the transport stream items and the Bezel menu functions are disabled except
for the TS Item menu where you set the start and stop packets for the transport
stream.

	� ����� ����
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In the Auto Update loop mode, you can change the following timing values:
PCR (Program Clock Reference), continuity_counter, PTS (Presentation Time
Stamp) / DTS (Decoding Time Stamp),  TDT (Time and Data Table) /TOT (Time
Offset Table), and STT (System Time Table).

The Stress loop mode is only available with the MTG300 MPEG Generator. In
the Stress loop mode, all of the real-time transport stream stress functions are
available.

	��� ������ ����
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This section provides the following tutorials to familiarize you with the basic
functions of the MPEG generator:

� Outputting a transport stream

� Changing the PCR interval (MTG300 only)

� Inserting an EIT (MTG300 only)

����. These tutorials do not cover all the features and functions of the MPEG
generator. The tutorials are intended to introduce you to the operations required
to execute the instrument’s basic functions.

Refer to the Reference section for detailed descriptions of the menus and
functions used in these procedures.

Before you perform these tutorials, make sure that the MPEG generator is
properly installed. Refer to Installation on page 1-6.

�������� ���������

Table 2-3 lists the equipment required to perform the tutorials. Accuracy of
alternate equipment should equal or exceed that of the example instruments and
accessories. Using inadequate equipment may result in inaccurate measurements.

���� ������������ ����������� ���� ��������� �� �����������

	��� 
�� ������������ ������ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

��� "�!" !&!"��
ÁÁ
ÁÁ
ÁÁ

�
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

���" ���% ������ �� ��! ���� ���� 	���&'� 
� ��#�$����"

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ�� � 
�� ���% �����

ÁÁ
ÁÁ�
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ���" ���% ��� ���(����(��



Tutorials

���� MTG100 & MTG300 MPEG Generator User Manual

���������� � 
�������� 	�����

The hard disk drive of the MPEG generator is shipped with files containing
factory-supplied samples of transport streams. This tutorial opens one of these
sample files and outputs the transport stream.

Perform the following steps to select and output a stored transport stream:

1. Press the front-panel MENU  button to enable the pull-down menu display.
When the pull-down menus are enabled, the name of the selected pull-down
menu is highlighted.

2. Use the left and right arrow buttons to select the FILE  pull-down menu.

3. Use the rotary knob or the up and down arrow buttons to select Open TS
File... from the menu, and then press the OK  bezel button to open the dialog
box shown in Figure 2-13.

������ ������	���� 
	 ���� ������ ���

4. Use the rotary knob or the arrow buttons to select the test64.trp file, and
then press the OK  bezel button. This displays the hierarchy view of the
transport stream file shown in Figure 2-14.
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5. Connect a 75 � cable between the ASI OUT  connector on the MPEG
generator rear panel to the ASI IN  connector of the MPEG test system.

6. Press the MPEG generator START/STOP button to start the transport
stream output. When transport stream output is started, the Output Status
indicator in the status bar changes from Stopped to Running.

7. Set up the MPEG test system to monitor the transport stream output from the
MPEG generator. Figure 2-15 shows the transport stream data displayed on a
Tektronix MTS200 Series Real Time Analyzer.

8. Press the START/STOP button on the MPEG generator to stop the transport
stream output. Observe that the Output Status indicator in the status bar
changed from Running to Stopped.
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This tutorial changes the PCR (Program Clock Reference) interval of the
transport stream data. The PCR is a time stamp in the transport stream from
which decoder timing is derived.

Perform the following steps to change the PCR interval (if your equipment is
still set up from the previous tutorial, proceed to step 6):

1. Press the front-panel MENU  button to enable the pull-down menu display.
When the pull-down menus are enabled, the name of the selected pull-down
menu is highlighted.

2. Use the left and right arrow buttons to select the FILE  pull-down menu.

3. Use the rotary knob or the up and down arrow buttons to select Open TS
File... from the menu, and then press the OK  bezel button to open the dialog
box shown in Figure 2-13.

4. Use the rotary knob or the arrow buttons to select the test64.trp file, and
then press the OK  bezel button. This displays the hierarchy view of the
transport stream file shown in Figure 2-14.
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5. Connect a 75 � cable between the ASI OUT  connector on the MPEG
generator rear panel to the ASI IN  connector of the MPEG test system.

6. Press the MPEG generator START/STOP button to start the transport
stream output. When transport stream output is started, the Output Status
indicator in the status bar changes from Stopped to Running.

7. Set up the MPEG test system to monitor the PCR interval in the transport
stream output from the MPEG generator (for example the PCR Analysis
mode in the Tektronix MTS215 or MTS205). Observe that the PCR interval
is 40 ms as measured on the MPEG test system.

8. Move the Icon cursor to a PCR icon in the hierarchy using the rotary knob.
Figure 2-16 shows the Icon cursor selecting a PCR icon.

��
����
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9. Press the Interval... bezel button, which opens the PCR Interval dialog box
shown in Figure 2-17.

������ ������
�� 	������ ����� ���

10. Set the PCR interval to 100 ms using either the rotary knob or the hexadeci-
mal keys. To use the hexadecimal keys, press the numbers you want for the
value, and then press the Enter key.



Tutorials

���� MTG100 & MTG300 MPEG Generator User Manual

11. Press the Keep Stress bezel button to accept the value change and close the
PCR Interval dialog box. Observe that when you changed the PCR interval
value, the color of the PCR interval value displayed to the right of the PCR
icon changed to orange to indicate a user-defined value.

12. Observe that the PCR interval is 100 ms as measured on the MPEG test
system. Figure 2-18 shows the PCR interval monitored by the Tektronix
MTS200 Series MPEG test system.

������ ��������� ������� ��������� �� ��� 
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13. Press the START/STOP button on the MPEG generator to stop the transport
stream output. Observe that the Output Status indicator in the status bar
changed from Running to Stopped.
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This tutorial inserts an EIT (Event Information Table) into the transport stream.
This EIT data is contained on the hard disk of the instrument as a file (*.eit).

Perform the following steps to insert an EIT:

1. Press the front-panel MENU  button to enable the pull-down menu display.
When the pull-down menus are enabled, the name of the selected pull-down
menu is highlighted.

2. Use the left and right arrow buttons to select the CONFIG  pull-down menu.

3. Use the rotary knob or the up and down arrow buttons to select Insert
Section/TS... from the menu, and then press the OK  bezel button to open
the Select Insert File dialog box shown in Figure 2-19.

������ �"��	������� ����� ���� ������ �� 

4. Use the rotary knob or the arrow buttons to select the Insert.eit file, and then
press the OK  bezel button. This displays the Insertion Setup dialog box
shown in Figure 2-20.
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5. Use the arrow buttons to highlight the PID parameter in the Insertion Setup
dialog box as shown in Figure 2-20.

6. Use the rotary knob to set the PID value to 18 (0x12), and then press the
Apply  bezel button to accept the settings and close the dialog box.

7. Press the START/STOP button to start transport stream output. When
transport stream output is started, the Output Status indicator in the status
bar changes from Stopped to Running.

8. Press the MENU  button to enable the Icon cursor in the hierarchy display.

9. Use the rotary knob to move the Icon cursor to the bottom of the hierarchy
display.

Observe that an INS_SI icon is added at the end of the hierarchy as shown in
Figure 2-21. The icon’s background is colored blue to indicate it has been
added by the user.

10. Connect a 75 � cable between the ASI OUT  connector on the MPEG
generator rear panel to the ASI IN  connector of the MPEG test system.

11. Set up the MPEG test system to monitor the transport stream output from the
MPEG generator. Figure 2-22 shows the transport stream data displayed on a
Tektronix MTS200 Series Real Time Analyzer with the GHOST icon shown.
In this case, the inserted EIT appears as a GHOST, since it is not referenced
in an appropriate table in the transport stream.
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The Reference section is divided into the following subsections:

� Bezel Menu describes how the bezel menu functions vary with the current
mode of the instrument.

� Pull-down Menus describes the function of each selection available in the
pull-down menus.

� Hierarchy Display describes the icons used by the MPEG generator to
represent transport stream elements, and lists the Bezel menu functions
available with each icon type.

� Replacing and Inserting Section Data (MTG300 Only) provides instructions
and procedures on how to replace and insert section data.

� Adding Jitter to PCRs (MTG300 Only) provides instructions and procedures
on how to add jitter to PCRs.

� Preset File provides information about the preset file and procedures on how
to save and load a preset file.

� File Operations provides procedures on how to create a new folder, copy a
file, delete a file or folder, and rename a file name or folder name.

����
 ���

The Bezel menu is the command menu that appears on the right side of the
screen next to the bezel buttons (see Figure 2-3 on page 2-7). Press the bezel
button associated with the displayed menu selection to make selections in the
Bezel menu. Which commands are displayed in the Bezel menu depends on the
following factors:

� The model of the instrument. The MTG300 MPEG Generator has more
functions available than the MTG100 MPEG Generator.

� When the Icon cursor is enabled, the Bezel menu functions change to match
the selected transport stream icon. When the Pull-down menus are enabled,
the Bezel menu functions change to interact with the selections you make in
the Pull-down menus.

� The current output loop mode. The Bezel menu selections change to match
which output loop mode is selected. Refer to Output Loop Modes on
page 2-15 for more information.
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The following subsection, Pull-down Menus, contains descriptions of the Bezel
menu commands that interact with the pull-down menus. Refer to Hierarchy
Display on page 3-25 for descriptions of the Bezel menu commands associated
with each type of transport stream element.
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This subsection describes the function of each selection available in the
pull-down menus and their associated Bezel menu selections. The four pull-
down menus listed in the Menu bar provide the following general functions:

� The FILE menu contains commands for managing various file operations.

� The OUTPUT menu contains commands for defining output parameters.

� The CONFIG menu contains commands for setting the output loop mode
and the initial PCR values, and inserting an insertion file and a TDT/TOT/
STT.

� The UTILITY menu contains commands for managing data storage
operations and network settings.

Refer to Basic Menu Operation on page 2-9 for information about how to
operate the menu system.
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The FILE pull-down menu contains commands for managing various file
operations. Table 3-1 describes the commands in the FILE pull-down menu.

����� �����	
�� ��������� ���� ���������

������� �����������

�+!) �� �%'!��� �+!). � ./-!�( "%'! ./*-! %) /$! �(�%)�0.-�/.  %-!�/*-4 *" /$! ����
#!)!-�/*-� �$!) 4*0 *+!) � )!2 /-�).+*-/ ./-!�( "%'!� /$! �0--!)/'4 .!/
%).!-/%*) "0)�/%*). �-! �'' ��)�!'! �

�$!) 4*0 .!'!�/ /$%. �*((�) � /$! �!'!�/ �� �%'!  %�'*# �*3 �++!�-.�
�!"!- /* ����
� �� �	��� ��� *) +�#!�	5
 "*- (*-! %)"*-(�/%*)�

�*� �-!.!/��� �*� . /$! .+!�%"%! +-!.!/ "%'! ��.!/�� �$!) � +-!.!/ "%'! %. '*� ! � /$!
�0--!)/ %)./-0(!)/ .!//%)#. �-! �$�)#! �4 /$! "%'!�. �*)/!)/� �!"!- /*
������ ��� �!#%))%)# *) +�#! 	5�
� "*- (*-! %)"*-(�/%*) ��*0/ /$!
+-!.!/ "%'!�

��1! �-!.!/��� ��1!. /$! �0--!)/ %)./-0(!)/ .!//%)#. �. � +-!.!/ "%'!� �!"!- /* ������
��� �!#%))%)# *) +�#! 	5�
� "*- (*-! %)"*-(�/%*) ��*0/ /$! +-!.!/ "%'!�

�!2 �*' !-��� �-!�/!. � )!2 "*' !- �.0� %-!�/*-4� 0) !- *)! *" /$! "*''*2%)#
"��/*-45.0++'%!  %-!�/*-%!. *) /$! $�-  %.&  -%1!� �(�%)�0.-�+-!.!/�
�(�%)�0.-�/.� *- �(�%)�0.-�%).!-/� �!"!- /* ��� ����	���� �!#%))%)# *)
+�#! 	5��� "*- (*-! %)"*-(�/%*) ��*0/ $*2 /* �-!�/! � )!2 "*' !-�

�*+4��� �*+%!. /$! .+!�%"%! "%'!� �*0 ��) �*+4 /$! "%'!. *)'4 %) /$! %).!-/ *-
+-!.!/  %-!�/*-4� �!"!- /* ��� ����	���� �!#%))%)# *) +�#! 	5��� "*-
(*-! %)"*-(�/%*) ��*0/ $*2 /* �*+4 � "%'!�

�!'!/!��� �!'!/!. /$! .+!�%"%! "%'! *- "*' !-� !"*-! /$! "%'! *- "*' !- %.  !'!/! � �
�*)"%-(�/%*)  %�'*# �*3 �++!�-. /* �*)"%-( /$!  !'!/! *+!-�/%*)� �*0
��))*/  !'!/! /$! �(�%)�0.-�/.� �(�%)�0.-�%).!-/� *- �(�%)�0.-�+-!.!/
 %-!�/*-%!. �!��0.! /$!.!  %-!�/*-%!. �-! -!,0%-! �4 /$! ����
#!)!-�/*-� �!"!- /* ��� ����	���� �!#%))%)# *) +�#! 	5��� "*- (*-!
%)"*-(�/%*) ��*0/ $*2 /*  !'!/! � "%'! *- � $*' !-�

�!)�(!��� �!)�(!. /$! .+!�%"%! "%'! *- "*' !-� �!"!- /* ��� ����	���� �!#%))%)#
*) +�#! 	5��� "*- (*-! %)"*-(�/%*) ��*0/ $*2 /* -!)�(! � "%'! )�(! *-
� $*' !- )�(!�



Pull-down Menus

MTG100 & MTG300 MPEG Generator User Manual �"�

When you select the Open TS File... command from the FILE pull-down menu,
the Select TS File dialog box appears as shown in Figure 3-1. Use the rotary
knob or the arrow buttons to highlight the desired file. Press the OK bezel button
or the left control button to load the highlighted file.

Table 3-2 describes the Select TS File dialog box parameters and Table 3-3
describes the Bezel menu commands associated with the dialog box.
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The OUTPUT pull-down menu contains commands for defining output
parameters. Table 3-4 describes the commands available in the OUTPUT
pull-down menu.

����� �!���
��� ����!���� ���� ���������

������� �����������

�')0+8  />+  +87 8.+ 5')0+8 7/>+ �/3 (=8+7� ,46 8.+ 786+'2� &49 )'3 7+8 8.+ 5')0+8 7/>+ 84

����
���� 	�� �	��
�� � 
��� �	� �
�� � �	� (=8+7� 46 �43 ! �

� ,/1+ *4;314'*+* /3 �43 ! 78'3*'6* /7 '1;'=7 498598 /3 �43 ! 78'3*'6*�

�, =49 ).'3-+ 8.+ 5')0+8 7/>+ 7+88/3-� 8.+ ���� -+3+6'846 5642587 =49 84
).'3-+ 8.+ )14)0?6'8+ 7+88/3-� �, =49 7+1+)8 &+7� 8.+ �14)0 */'14- (4<
'55+'67 84 .':+ =49 )43,/62 46 ).'3-+ 8.+ )14)0?6'8+ 7+88/3-� �+,+6 84 �����
����� ��� 43 5'-+ �?� ,46 246+ /3,462'8/43�

�14)0���  +87 8.+ )14)0 6'8+ 4, 8.+ 86'375468 786+'2 498598� $.+3 =49 7+1+)8 8./7
2+39 /8+2� 8.+ �14)0 */'14- (4< '55+'67� �+,+6 84 ����� ����� ��� 43
5'-+ �?� ,46 246+ /3,462'8/43�

�7=3)  +87 8.+ ,462'8 4, 8.+ � &�� 7/-3'1 498598 ,642 8.+ ����!!���#� �"!
)433+)846� &49 )'3 7+1+)8 �462'1 46 �?!���� �46 �462'1� ' 7/3-1+ 5917+
7/-3'1 /7 498598 '8 8.+ 78'68 54/38 4, +'). 5')0+8� �46 �?!���� ' 7/3-1+
5917+ /7 498598 '8 8.+ 78'68 54/38 4, 8.+  � '55+'6/3- +:+6= �	 % � %�
(=8+7� &49 )'3348 7+8 8./7 5'6'2+8+6 ,46 8.+ �43 ! 78'3*'6* ,/1+�

�+:+1  +87 8.+ 7/-3'1 1+:+1 ,46 8.+ ����!!���#� �"! )433+)846 43 8.+ 6+'6
5'3+1� &49 )'3 7+1+)8 !!�� ����� 46 �#� �

�48+� �46 ����� 8.+ 7/-3'1 1+:+1 /7 1+77 8.'3 8.+ 8=5/)'1 ��� 7/-3'1 1+:+1�
�+,+6 84 ����		���
�� ������ /3 !'(1+ �?� 43 5'-+ 	?��

�38+6,')+ "7+ 8./7 )422'3* 84 7+8 8.+ 498598 ,462'8 ,46 8.+ ����!!���#� �"!
)433+)846 43 8.+ 6+'6 5'3+1� &49 )'3 7+1+)8 �'6'11+1 46  +6/'1 ,462'87�

� � �462'8  +87 8.+ /37+68/43 24*+ ,46 8.+ � � �"! )433+)846 43 8.+ 6+'6 5'3+1� &49
)'3 7+1+)8 �')0+8 46 �9678 /37+68/43 24*+7� �46 8.+ �')0+8 24*+� :'1/* *'8'
/7 498598 5+6 86'375468 786+'2 5')0+8� �46 �9678 24*+� 8.+ :'1/* *'8' /7
498598 /3 (9678�

When you select the Clock... command from the OUTPUT pull-down menu, the
Clock dialog box appears as shown in Figure 3-2. Use the arrow buttons to
highlight the desired parameter, and then use the rotary knob or hexadecimal
keypad to set values. Press the OK bezel button to apply changes.

Table 3-5 describes the Clock dialog box parameters and Table 3-6 describes the
Bezel menu commands associated with the dialog box.
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The CONFIG pull-down menu contains commands for setting the output loop
mode and the initial PCR values, and inserting an insertion file and a TOT/STT.
Table 3-7 describes the commands available in the CONFIG pull-down menu.
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�'�%'��"� �����' ��� #� �#*� When you select the Start/End Packet... command
from the Bezel menu on your MTG300 MPEG generator, the Start/End Packet
dialog box appears as shown in Figure 3-14. Use the arrow buttons to highlight
the desired parameter, and the use the rotary knob or hexadecimal keypad to set
the value. Press the Apply bezel button to apply changes.

Table 3-8 describes the Start/End Packet dialog box parameters and Table 3-9
describes the Bezel menu commands associated with the dialog box.
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When you select the PCR Initial Value... command from the CONFIG pull-down
menu, the PCR Start Value dialog box appears as shown in Figure 3-4. Use the
arrow buttons to highlight the desired parameter, and then use the rotary knob or
hexadecimal keypad to set values. Press the OK bezel button to apply changes.

Table 3-10 describes the PCR Start Value dialog box parameters and Table 3-11
describes the Bezel menu commands associated with the dialog box.
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When you select the Insert Section/TS... command from the CONFIG pull-down
menu, or you select INS_SI... from the Bezel menu of a selected INS_SI icon in
the hierarchy display, or you select INS_TS... from the Bezel menu of a selected
INS_TS icon in the hierarchy display, the Insertion Setup dialog box appears as
shown in Figure 3-5. Use the arrow buttons to highlight a parameter, and then
use the rotary knob or hexadecimal keypad to set the value. Press the Apply
bezel button to apply changes.

Table 3-12 describes the Insertion Setup dialog box parameters and Table 3-13
describes the Bezel menu commands associated with the dialog box.

��(%� �,�	��"&�%'�#" ��'($ ��� #� �#)

�"&�%'�#" ��'($ ��� #�


#) ������� �" *�



Pull-down Menus

MTG100 & MTG300 MPEG Generator User Manual ����


���� ��������������� 	���� ������ ��� �����������

��������� ����������

�+-'/#.' �*073 4*' &+2'%4029 1#4* #/& /#.' 0( 4*' 3'%4+0/ 02 42#/31024 342'#. (+-'
3'-'%4'& +/ 4*' �'-'%4 �/3'24 �+-' &+#-0) $08� �*' &'(#5-4 &+2'%4029 1#4* +3
�.#+/�532�+/3'24�

�#$-' �� �*073 4*' 4#$-'"+& 6#-5' 0( 4*' 4#$-' %022'310/&+/) 40 4*' 3'%4+0/ (+-'� �*'
6#-5' +3 #540.#4+%#--9 &'(+/'& $9 4*' 3'-'%4'& (+-'�

�*+3 1#2#.'4'2 #11'#23 0/-9 7*'/ 4*' 3'-'%4'& +/3'24+0/ (+-' +3 # 3'%4+0/ (+-'�

�+-' �+:' �*073 4*' 3+:' 0( 4*' 3'-'%4'& 3'%4+0/ 02 42#/31024 342'#. (+-'�

�+.' �934'. �*073 4*' 2'('2'/%' 4+.' 53'& $9 4*' �4#24 �+.' 1#2#.'4'2 40 34#24 4*' (+-'
+/3'24+0/� �'-#4+6'� ���� ���� 02 ���� �'-#4+6' +3 &+31-#9'& 7*'/ # ����
���� 02 ��� +3 /04 12'3'/4 +/ 4*' 42#/31024 342'#.� ���� ���� 02 ��� +3
&+31-#9'& 7*'/ # ���� ���� 02 ��� +3 12'3'/4 +/ 4*' 42#/31024 342'#.�

���  *'/ 4*' +/3'24+0/ (+-' +3 # 3'%4+0/ (+-'� 4*+3 1#2#.'4'2 3'43 4*' ��� 6#-5'
7*'/ 4*' 3'%4+0/ (+-' +3 1#%,'4+:'&� !05 %#/ 3'4 4*' 6#-5' (20. � 40 ���
��8���� 40 �8������

 *'/ 4*' +/3'24+0/ (+-' +3 # 42#/31024 342'#.� 4*+3 1#2#.'4'2 3'43 4*' ���
6#-5' 0( 4*' 42#/31024 342'#. 1#%,'4 �(+-'�� !05 %#/ 3'4 4*' 6#-5' (20.
� 40 ��� ��8���� 40 �8������

 *'/ 905 #%%'33 4*' �/3'24+0/ �'451 &+#-0) $08 (20. #/ ���"�� 02 ���"��
+%0/ +/ 4*' *+'2#2%*9 &+31-#9� 4*+3 1#2#.'4'2 +3 #540.#4+%#--9 3'4 $9 4*'
342'#. +4'. #/& %#//04 $' %*#/)'&�

�'%4+0/ �'43 4*' .0&' (02 *07 3'%4+0/ &#4# 7+-- $' %0/4#+/'& +/ 4*' 42#/31024 342'#.
1#%,'43� !05 %#/ 3'-'%4 ������ 02 ������ �'('2 40 �����	� �	��
 0/
1#)'�
<
 (02 .02' +/(02.#4+0/�

�*+3 1#2#.'4'2 #11'#23 0/-9 7*'/ 4*' 3'-'%4'& +/3'24+0/ (+-' +3 # 3'%4+0/ (+-'�

�4#24 �+.' �'43 4*' 4+.' 7*'/ (+-' +/3'24+0/ +3 34#24'&� !05 %#/ 3'4 4*' 4+.' 6#-5' (20.
������������ 40 	�����������;�*0523;�;.+/54'3;�;3'%0/&3;�;.+--+3'%0/&3��
�07 4*+3 �4#24 �+.' 1#2#.'4'2 702,3 &'1'/&3 0/ 4*' 3'44+/) 0( 4*' �+.'
�934'. 1#2#.'4'2 +/ 4*+3 &+#-0) $08�

 *'/ 4*' �+.' �934'. 1#2#.'4'2 +3 �'-#4+6'� (+-' +/3'24+0/ 34#243 7*'/ 4*'
1'2+0& 0( 4+.' 3'4 +/ 4*+3 �4#24 �+.' 1#2#.'4'2 *#3 '-#13'& #(4'2 4*' 34#24 0(
4*' 42#/31024 342'#. 054154�

 *'/ 4*' �+.' �934'. 1#2#.'4'2 +3 ���� ���� 02 ���� (+-' +/3'24+0/ 34#243
7*'/ 4*' 4+.' &'3%2+$'& +/ 4*' ���� ���� 02 ��� 0( 4*' 42#/31024 342'#.
%022'310/&3 40 4*' 4+.' 3'4 +/ 4*+3 �4#24 �+.' 1#2#.'4'2� �02 53'2<+/3'24'&
���3� ���3� #/& ���3� 4*' ��� �4'.� ��� +4'.� #/& ��� �4'. &+#-0)
$08'3 %0/4#+/ # 1#2#.'4'2 40 3'4 4*' 34#24 4+.'�  *'/ 4*' 34#24 4+.' 3'44+/)
+/ 4*+3 &+#-0) $08 .#4%*'3 4*' 34#24 4+.' 3'44+/) +/ 4*' ��� �4'.� ��� +4'.�
02 ��� �4'. &+#-0) $08� (+-' +/3'24+0/ +3 34#24'&�

�0/4+/5053 �'43 4*' &52#4+0/ (02 4*' (+-' +/3'24+0/�  *'/ 905 3'-'%4 ����� 905 %#/ 3'4
4*' 4+.' 6#-5' (20. ������������ 40 	�����������;�*0523;�;.+/54'3;�;3'<
%0/&3;�;.+--+3'%0/&3��  *'/ 905 3'-'%4 �������� 02 3'4 4*' 4+.' 6#-5' 40
������������� 4*' (+-' +/3'24+0/ &52#4+0/ +3 3'4 40;+/(+/+4'�



Pull-down Menus

�*�	 MTG100 & MTG300 MPEG Generator User Manual

����� �*��
�� $�#%�! ��%&" ����!� �!' "�#���%�#$���! %��

��#���%�# �$�#�"%�! 

�� � "'�%)� ��'& '�� '�!� �"'�%)� ��'*��" �� � �"&�%'�#"&� ��� �"&�%'�#" �� � *�  ��
%�$��'�� , �"&�%'�� �"'# '�� '%�"&$#%' &'%��! #('$(' �' '�� &$������� '�!�
�"'�%)� � �#( ��" &�' '�� �"'�%)� �%#! ��� !& '# ���� !& �" �� !& &'�$&�

�����' "'�%)� 	�'� �" '�� �"&�%'�#" �� � �& $����'�-�� �, '�� ��
� ��"�%�'#% $%�#% '# ���"�
�"&�%'�� �" '�� '%�"&$#%' &'%��! #('$('� �&� '��& $�%�!�'�% '# &�' '�� '�!�
�"'�%)� ��'*��" '�� $����'& #� '�� �"&�%'�#" �� �� �#( ��" &�' '�� $����'
�"'�%)� �%#! � '# �����$����'& �" � $����' &'�$&�

����� �*��
���)�� �� & �!��� �$ �!# %�� � $�#%�! ��%&" ����!� �!'�

�!��� � �$�#�"%�! 

	���( ' ��&�'& �  #� '�� ��� #� �#+ &�''�"�& ���� '# '�� ���'#%, ����( ' &�''�"�&�

��"�� ��"�� & �", &�''�"� ���"��& �"� � #&�& '�� ��� #� �#+�

�$$ , 
"�� �& �  &�''�"� ���"��&� ���" ,#( �$$ , &�''�"� ���"��&� ��'� #('$('
�%#! '�� ��
� ��"�%�'#% �& &'#$$��� �#( !(&' %�&'�%' '�� ��
� ��"�%�'#%
#('$(' �#% '�� &�''�"� ���"��& '# �$$��%�

When you select the Insert TOT/TDT... command from the CONFIG pull-down
menu or you select TDT... or TOT... from the Bezel menu of a selected TDT or
TOT icon in the hierarchy display, the TOT Item or TDT Item dialog box
appears. Figure 3-6 shows the TOT Item dialog box. Use the arrow buttons to
highlight the desired parameter, and then use the rotary knob or hexadecimal
keypad to set values. Press the Keep Stress bezel button to apply changes.

����. The TDT Item or TOT Item dialog box is available from the CONFIG
pull-down menu only when the selected transport stream file is in ARIB or DVB
formats and a TDT (Time and Data Table) or TOT (Time Offset Table) does not
already exist in the transport stream.

Table 3-14 describes the TOT Item dialog box parameters and Table 3-15
describes the Bezel menu commands associated with the dialog box.
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When you select the Insert STT... command from the CONFIG pull-down menu
or you select STT... from the Bezel menu of a selected STT icon in the hierarchy
display, the STT Item dialog box appears as shown in Figure 3-7. Use the arrow
buttons to highlight the desired parameter, and then use the rotary knob or
hexadecimal keypad to set values. Press the OK bezel button to apply changes.

����. The STT Item dialog box is available from the CONFIG pull-down menu
only when the selected transport stream file is in ATSC format and an STT
(System Time Table) does not already exist in the stream.
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The STT Item dialog box allows you to set and control Daylight Savings time
parameters. Refer to Controlling Daylight Savings Time on page 3-17 for more
information.

Table 3-16 describes the STT Item dialog box parameters and Table 3-17
describes the Bezel menu commands associated with the dialog box.
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The MTG300 MPEG generator provides the capability to change the status of
the three fields in the STT that control daylight savings time: the DS_status,
DS_day_of month, and DS_hour. Using this feature, you can test that the
receiver can switch into or out of daylight savings time at the appropriate local
time. This subsection explains the relationship between the daylight savings time
parameter settings in the STT Item dialog box and the status of the three fields in
the STT.

Table 3-16 describes the DS Mode, Precede DS In, DS In, Precede DS Out, and
DS Out parameters, which control the daylight savings time fields in the STT
Item dialog box. The MPEG generator converts the entered daylight savings time
parameters to seconds when performing calculations. Figure 3-8 shows the
relationship between the daylight savings time parameters.
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Table 3-18 shows the relationship between the parameters in the STT Item dialog
box and the status of the daylight savings fields (DS_status, DS_day_of_month,
and DS_hour) in the STT.
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The UTILITY pull-down menu contains commands for setting the network
configuration, defragmenting the hard disk, or setting system parameters. This
menu is also used to perform the instrument self test or reset the instrument
settings to the factory defaults. Table 3-19 describes the commands available in
the UTILITY pull-down menu.
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Use the Network dialog box to set network parameters for the Ethernet port on
the MPEG generator. These parameters will be used when you connect the
MPEG generator to a remote computer (PC) so that you can transfer stream files
between the MPEG generator and the PC. Refer to Appendix B: Using
MTG Comm+ for File Transfers for information about connecting the MPEG
generator to a PC.

When you select the Network... command from the UTILITY pull-down menu,
the Network dialog box appears as shown in Figure 3-9. Use the arrow buttons to
highlight the desired parameter, and then press the Edit... bezel button to open a
dialog box for inputting the address. Use the hexadecimal keypad to set the
address. Press the OK bezel button to apply changes.

�� "��� ������ ��#
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Table 3-20 describes the Network dialog box parameters and Table 3-21
describes the Bezel menu commands associated with the dialog box.

����� ������������ ��	�� 
��

The settings you enter in the Network dialog box depend on how you connect the
MPEG generator to the remote PC. You can connect the MPEG generator
directly to a single PC or you can connect it to your local Ethernet network
where the MPEG generator can be accessed by network PCs running the
MTG Comm+ application.

If you connect the MPEG generator directly to a single PC, use the following
procedure to set the Network dialog box parameters:

����. You must exit the Network dialog box before your setting changes will
take effect.

1. Set the DHCP Client parameter to Disable.

2. Set the IP Address parameter to be the same IP address as the PC’s address
except for the last number. The last number must be different than the last
number in the PC’s IP address.

3. Set the Subnet Mask parameter to be the same subnet mask used by the PC.
Do not enter a number if the PC does not have a subnet mask.

4. You do not need to enter a Routing Destination or Routing Gateway if you
are directly connected to a single PC.
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If you connect the MPEG generator to your local Ethernet network, you can
access the MPEG generator using any PC on the network running the
MTG Comm+ application.

�������� To prevent communication conflicts on your network, ask your local
network administrator for the correct numbers to enter in the Network dialog
box if you connect the MPEG generator to your local Ethernet network.
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When you select the Drive... command from the UTILITY pull-down menu, the
Drive dialog box appears as shown in Figure 3-10. The dialog box displays the
identification of the TS drives, the status of the clusters, and the percentage of
fragmentation.

Table 3-22 describes the Bezel menu commands associated with the dialog box.

�������� To prevent the loss of your TS data, consider the following operating
conditions before you select the Defrag TS drive command:

� You cannot interrupt the file defragmenting function after it has started
except by turning the instrument off using the power switch. Power loss during
the defragmenting function may result in the loss of all TS data.

� The period of time the MPEG generator takes to defragment the TS files
depends on the amount of data stored on them. If the disk storage is near full
capacity, it may take 2–3 hours to complete the operation. No data output is
possible while the files are being degramented.
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When you select the System... command from the UTILITY pull-down menu,
the System dialog box appears as shown in Figure 3-11. The dialog box displays
the internal date and time of the MPEG generator and displays general system
information including the software and hardware versions installed in the
instrument and the compression standards supported by the instrument. Use the
arrow buttons to highlight the desired parameter, and then use the rotary knob or
hexadecimal keypad to set values.

Table 3-23 describes the System dialog box parameters and Table 3-24 describes
the Bezel menu commands associated with the dialog box.
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The MPEG generator displays the selected transport stream using a hierarchy
structure. This section describes the hierarchy display, defines each icon you may
encounter in the display, and describes the Bezel menu functions associated with
each type of hierarchy icon.

��
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� �� ��
 �
���	�� ������

The MPEG generator uses icons displayed in a hierarchical structure to show the
interrelationship of transport stream components (see Figure 3-12). Additional
information about each stream component such as PID and Table ID numbers is
displayed next to each icon. Icons that represent data inserted by the user using
the MPEG generator are displayed with a blue background to distinguish them
from the standard transport stream icons.

The “+” symbol displayed to the left of some icons indicates that the item
includes lower-level transport stream components that are not displayed. The
symbol changes to “–” when the lower level components are displayed. To
expand or collapse the hierarchy, select the desired upper-level icon and press the
left control button.

When a transport stream contains more items than will display on the screen at
one time, a scroll bar appears at the right of the screen.

�������� All PSI or PSIP information must be placed within the first 8 Mbytes
of a transport stream file downloaded using the MTG Comm application. If the
PSI or PSIP information is not in the first 8 Mbytes, the hierarchy icons for the
PSI or PSIP information may not be displayed correctly. Refer to Appen-
dix B:Using MTG Comm for File Transfers for more information about the
MTG Comm application.

The Icon cursor is used to select individual transport stream components as
represented by the icons. The Icon cursor is displayed as a red square (border)
surrounding a hierarchy icon (see Figure 3-12). Use the rotary knob or the arrow
buttons to move the Icon cursor through the hierarchy. The hierarchy display
scrolls (if applicable) when the Icon cursor reaches the top or bottom of the
displayed portion of the hierarchy.

When the pull-down menus are enabled, the Icon cursor is not displayed. Press
the front-panel MENU button to toggle control between the Icon cursor and the
pull-down menus.
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Table 3-25 describes the icons you may encounter in the hierarchy display of the
MPEG generator for transport streams using the MPEG-2, ARIB, DVB, and
ATSC formats.

Table 3-26 on page 3-29 describes icons that are specific to transport streams
using DVB format.

Table 3-27 on page 3-30 describes icons that are specific to transport streams
using ARIB  format.

Table 3-28 on page 3-32 describes icons that are specific to transport streams
using the ATSC format.

Table 3-29 on page 3-33 describes icons that are specific to transport streams
using the S-TMCC or M-TMCC format and to streams using the Non TS format.

Table 3-30 on page 3-33 describes icons that represent the user-inserted data
inserted by the MPEG generator.

Refer to Icon Text and Bezel Menu Commands on page 3-34 for descriptions of
the icon text and Bezel menu commands associated with each hierarchy icon.
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To the right of each icon, the MPEG generator displays text that describes each
transport stream component. The text associated with an icon will change color
to indicate the following conditions:

� Red text indicates that the selected transport stream is not suited for
outputting with the Auto Update loop mode. The No Update loop mode is
recommended for outputting it.

� Orange text indicates that the parameters of the component have been
changed from its default value.

� Green text indicates that the component has been replaced with the specified
section file.

When you use the Icon cursor to select a transport stream component, the Bezel
menu displays commands that apply only to the selected component (MTG300
only). This subsection describes the text information and available Bezel menu
commands for each icon type.

����. Only the MTG300 MPEG generator can access the Bezel menu com-
mands for the selected transport stream icon. The output loop mode must be set
to Stress for all of the available Bezel menu commands to appear. Refer to
Output Loop Modes on page 2-15 for more information.

Table 3-31 describes the text information and Table 3-32 describes the Bezel
menu commands for the Transport Stream (TS) icon.
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�� 
�� ������ ����� ���� When you select the Stress TS Head... command
from the Bezel menu on your MTG300 MPEG generator, the TS Head Stress
dialog box appears as shown in Figure 3-13. The stress tests activated from this
dialog box are momentary and can only be applied when this dialog box is
displayed. Any transport stream setting changes applied by a test revert to their
prior state when the test is completed.

Use the arrow buttons to highlight the test you want to execute, and then press
the Effect Check bezel button to enable the test. A check mark (�) appears by
the enabled test. Only one test can be executed at a time. Press the Apply bezel
button to execute the enabled test. If you set to 0 in the Count box, the selected
test is repeated infinitely.

Table 3-33 describes the TS Head Stress dialog box parameters and Table 3-34
describes the Bezel menu commands associated with the dialog box.
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�$�"$���� �����$ ��� � � &� When you select the Start/End Packet... command
from the Bezel menu on your MTG300 MPEG generator, the Start/End Packet
dialog box appears as shown in Figure 3-14. Use the arrow buttons to highlight
the desired parameter, and the use the rotary knob or hexadecimal keypad to set
the value. Press the Apply bezel button to apply changes.

Table 3-35 describes the Start/End Packet dialog box parameters and Table 3-36
describes the Bezel menu commands associated with the dialog box.
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������ !!�! �#!�"" ������ 
�%� When you select the  Random Error... command
from the Bezel menu on your MTG300 MPEG generator, the Random Error
Stress dialog box appears as shown in Figure 3-15. Use the rotary knob or
hexadecimal keypad to set the interval. Press the Apply bezel button to apply the
random error stress to the transport stream output.

Table 3-37 describes the Random Error Stress dialog box parameters and Table 
3-38 describes the Bezel menu commands associated with the dialog box.
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Table 3-39 describes the text information and Table 3-40 describes the Bezel
menu commands for the Program Allocation Table (PAT) icon.
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��� ��#�!%�� ������ ��&� When you select the Interval... command from the Bezel
menu on your MTG300 MPEG generator, the PAT Interval dialog box appears as
shown in Figure 3-16.

The PAT interval parameter sets the time between occurrences of the PAT in the
transport stream. Use the rotary knob or hexadecimal keypad to change the
interval. You can set the value from 50 ms to 30000 ms in 1 ms steps.

Table 3-41 describes the Bezel menu commands associated with the dialog box.
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��� " �!! ������! "�� ��� ��"� $��� ���� '�# ������ "�� ��� ��"� $��� "�� ��%
��"� $�� $��#� �! ��!���'�� �� � ���� ��"� "�� ��� �����

�� ���� ��#$ ������ 
�&� When you select the Replace Section... command from
the Bezel menu on your MTG300 MPEG generator, the Replace Setup dialog
box appears as shown in Figure 3-17. Use the arrow buttons to highlight the
desired parameter, and then use the rotary knob or hexadecimal keypad to set
values. Press the Apply bezel button to apply changes.

Table 3-42 describes the Replace Setup dialog box parameters and Table 3-43
describes the Bezel menu commands associated with the dialog box.
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Table 3-44 describes the text information and Table 3-45 describes the Bezel
menu commands for the Transport Stream Description Table (TSDT) icon.
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Table 3-46 describes the text information and Table 3-47 describes the Bezel
menu commands for the Network Information Table (NIT) icon.
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Table 3-48 describes the text information and Table 3-49 describes the Bezel
menu commands for the Conditional Access Table (CAT) icon.
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Table 3-50 describes the text information and Table 3-51 describes the Bezel
menu commands for the Program Map Table (PMT) icon.
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��� �"'�%)� ��� #� #*� When you select the Interval... command from the Bezel
menu on your MTG300 MPEG generator, the PMT Interval dialog box appears
as shown in Figure 3-18.

The PMT interval parameter sets the time between occurrences of the PMT in
the transport stream. Use the rotary knob or hexadecimal keypad to change the
interval. You can set the value from 50 ms to 30000 ms in 1 ms steps.

Table 3-52 describes the Bezel menu commands associated with the dialog box.
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Table 3-53 describes the text information and Table 3-54 describes the Bezel
menu commands for the Program Clock Reference (PCR) icon.
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�� �!&�$(�� ����"� �")�When you select the Interval... command from the Bezel
menu on your MTG300 MPEG generator, the PCR Interval dialog box appears
as shown in Figure 3-19.

The PCR interval parameter sets the time between occurrences of the PCR in the
transport stream. Use the rotary knob or hexadecimal keypad to change the
interval. You can set the value from 20 ms to 10000 ms in 1 ms steps.

Table 3-55 describes the Bezel menu commands associated with the dialog box.
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� ������ ������ 	��� When you select the Stress PCR... command from the
Bezel menu on your MTG300 MPEG generator, the PCR Stress dialog box
appears as shown in Figure 3-20. The stress tests activated from this dialog box
can only be applied when the dialog box is displayed. Any transport stream
setting changes applied by a test revert to their prior state when you exit the
dialog box.

The PCR Stress dialog box allows you to run two tests: Interval Jitter and
Value Jitter. Use the arrow buttons and hexadecimal keypad or rotary knob to set
test parameters, and then press the Interval or Value bezel buttons so that Apply
is highlighted to enable the desired test. Both jitter tests can be executing at the
same time.

Refer to Adding Jitter to PCRs on page 3-89 for more information.

Table 3-56 describes the PCR Stress dialog box parameters and Table 3-57
describes the Bezel menu commands associated with the dialog box.
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Table 3-58 describes the text information and Table 3-59 describes the Bezel
menu commands for the video elementary stream (VIDEO) icon.
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��� �)'�(( �!�"%� �%+� When you select the DTS Stress... command from the
Bezel menu on your MTG300 MPEG generator, the DTS Stress dialog box
appears as shown in Figure 3-21. This function is available only when the dialog
box is displayed.

The Delay parameter sets the delay time for the DTS. You can set the delay from
0/90 kHz to 4500/90 kHz (0 ms to 50 ms). The transport stream output is varied
as the value is changed. Use the rotary knob or hexadecimal keypad to change
the delay.

Table 3-60 describes the Bezel menu commands associated with the dialog box.
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Table 3-61 describes the text information and Table 3-62 describes the Bezel
menu commands for the audio elementary stream (AUDIO) icon.
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Table 3-63 describes the text information and Table 3-64 describes the Bezel
menu commands for the AUDIO_AAC and AUDIO_AC3 (ATSC only) icons.
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Table 3-65 describes the text information and Table 3-66 describes the Bezel
menu commands for the data stream (DATA) icon.
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Table 3-67 describes the text information and Table 3-68 describes the Bezel
menu commands for the private section (DATA_SECT) icon.
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Table 3-69 describes the text information and Table 3-70 describes the Bezel
menu commands for the digital storage media command and control (DSM_CC)
icon.
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Table 3-71 describes the text information and Table 3-72 describes the Bezel
menu commands for the Entitlement Control Message (ECM) icon. The items
labeled “Section data only” do not appear when the ECM is a PES (Packetized
Elementary Stream) packet.
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menu on your MTG300 MPEG generator, the Stress SI dialog box appears as
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displayed.

The Reserved parameter selects whether the value 00 or 11 (binary) is written in
the reserved bits.

Table 3-73 describes the Bezel menu commands associated with the dialog box.
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Table 3-74 describes the text information and Table 3-75 describes the Bezel
menu commands for the Entitlement Management Message (EMM) icon. The
items labeled “Section data only” do not appear when the EMM is a PES
(Packetized Elementary Stream) packet.
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Table 3-76 describes the text information and Table 3-77 describes the Bezel
menu commands for the GHOST icon.
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Table 3-78 describes the text information and Table 3-79 describes the Bezel
menu commands for the Private Information (PRI) icon.
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Table 3-80 describes the text information and Table 3-81 describes the Bezel
menu commands for the Adaptation Field Error (ADFERR) icon.
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Table 3-82 describes the text information and Table 3-83 describes the Bezel
menu commands for the NULL icon.
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Table 3-84 describes the text information and Table 3-85 describes the Bezel
menu commands for the GARBAGE icon.
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Table 3-86 describes the text information and Table 3-87 describes the Bezel
menu commands for the Service Description Table (SDT), Bouquet Association
Table (BAT), Event Information Table (EIT), Running Status Table (SRT),
Stuffing Table (ST), Discontinuity Information Table (DIT), Selection Informa-
tion Table (SIT), Local event Information Table (LIT), Event Relation Table
(ERT), Index Transmission Table (ITT), Partial Content Announcement Table
(PCAT), Software Download Trigger Table (SDTT),  Download Control Table
(DCT), and DownLoad Table (DLT) icons.
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Table 3-88 describes the text information and Table 3-89 describes the Bezel
menu commands for the Time and Data Table (TDT) and Time Offset Table
(TOT) icons.
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Table 3-90 describes the text information and Table 3-91 describes the Bezel
menu commands for the Master Guide Table (MGT) and Program Identifier
Table (PIT) icons.
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Table 3-92 describes the text information and Table 3-93 describes the Bezel
menu commands for the Terrestrial Virtual Channel Table (TVCT), Cable Virtual
Channel Table (CVCT),  Rating Region Table (RRT), Event Information Table
(EIT), Channel Extended Text Table (CETT), and Event Extended Text Table
(EETT) icons.
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Table 3-94 describes the text information and Table 3-95 describes the Bezel
menu commands for the System Time Table (STT) icon.
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Table 3-96 describes the text information for the S-TMCC and M-TMCC icons.
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Table 3-97 describes the text information for the Transport Stream (TS) icon
used with the S-TMCC and M-TMCC icons.
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Table 3-98 describes the text information for the Non Transport Stream (Non TS)
icon.
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Table 3-99 describes the text information and Table 3-100 describes the Bezel
menu commands for the Service Information insertion file (INS_SI) icon.
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Table 3-101 describes the text information and Table 3-102 describes the Bezel
menu commands for the INS_TS (TS insertion file) icon.
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Table 3-103 describes the text information and Table 3-104 describes the Bezel
menu commands for the INS_TDT (TDT inserted by the MPEG generator) and
INS_TOT (TOT inserted by the MPEG generator) icons.
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Table 3-105 describes the text information and Table 3-106 describes the Bezel
menu commands for the INS_STT (STT inserted by the MPEG generator) icon.
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The MTG300 MPEG Generator provides the capability to replace section data
such as CATs, NITs, PATs, and PMTs in a transport stream with user-specified
data. The MPEG generator also allows you to insert user-specified section data
into a transport stream.

These features allow you to change the status of SI or PSI tables to check if a
receiver is operating correctly when the table information is updated.

����. The MPEG generator uses files stored in the /main/usr/insert directory on
the hard disk to replace or insert user-specified section data. Therefore, before
you can replace or insert section data, an appropriate section file must be stored
on the hard disk.

For example, if you want to replace the PMT in a transport stream, you must
first store a *.pmt file in the /main/usr/insert directory on the hard disk.

This subsection provides instructions on how to replace or insert section data
into the transport stream.

�������� ������� ����

Perform the following procedure to replace section data in the transport stream:

1. Use the Icon cursor to select the transport stream item in the hierarchy
display that you want to replace. If the Icon cursor is not displayed, press the
MENU  button to enable the Icon cursor.

2. Press the Replace Section... bezel button. This opens the Select Replace
File dialog box shown in Figure 3-23.

3. In the Select Replace File dialog box, select the section file that you want to
use as the replacement file.

4. After you select the desired replacement file, press the OK  bezel button.
This closes the Select Replace File dialog box and opens the Replace Setup
dialog box shown in Figure 3-24.
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5. The Replace Setup dialog box lets you set the parameters for how the section
data will be replaced and packetized. Refer to Replace Setup Dialog Box on
page 3-42 for information about the dialog box parameters.

Refer to Section Modes on page 3-83 for detailed information about the
Section parameter, and refer to Replacement Modes on page 3-84 for
detailed information about the Replace Mode parameter.

6. After you set the Replace Setup dialog box parameters, press the Apply
bezel button to confirm the settings, close the dialog box, and start the
section data replacement.

When section data replacement starts, the text information for the new file is
displayed in yellow-green after the text information displayed for the
transport stream item you are replacing.
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The replacement section data (section data file) is packetized by the MPEG
generator to produce transport stream packets when you replace section data in a
transport stream. The MPEG generator provides two section modes, Single and
Multi, to let you set whether one (Single), or more than one (Multi) section data
is contained in a transport stream packet. This subsection describes the difference
between these two section modes.

������ ������� 
��� In the Single section mode, only one section data is
contained in one transport stream packet. Figure 3-25 shows how section data are
transformed into transport stream packets for the Single section mode. In this
example, two section data are divided into four transport stream packets.
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���� ������� 
��� In the Multi section mode, two or more section data are
contained in one transport stream packet. Figure 3-26 shows how section data are
transformed into transport stream packets for the Multi section mode. In this
example, two section data are divided into three transport stream packets. The
Multi section mode minimizes the length of the transport stream data.
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The MPEG generator provides two replacement modes in the Replace Setup
dialog box for replacing the selected section data: Section End and Timing. This
subsection describes the differences between these two modes.

������ 	�� ����������� ����� In the Section End replacement mode (see
Figure 3-27), data replacement starts when the following conditions occur:

� The time set in the Start Time parameter of the Replace Setup dialog box
arrives

� The packet with payload_unit_start_indicator value 0x0001 is detected

After the time set in the Continuous Time parameter of the Replace Setup dialog
box arrives, data replacement is ended.
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������ 
��������� 	���� In the Timing replacement mode (see Figure 3-28),
data replacement starts immediately when the time set in the Start Time
parameter of the Setup Replace dialog box arrives.

After the time set in the Continuous Time parameter of the Setup Replace dialog
box arrives, the data replacement is ended.
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Perform the following procedure to insert section data into the transport stream:

1. Open the CONFIG  pull-down menu. If the pull-down menus are not enabled
(the Icon cursor is displayed), press the MENU  button to enable the
pull-down menus.

2. Select the Insert Section/TS... command, and then press the OK  bezel
button. This opens the Select Insert File dialog box shown in Figure 3-29.

	����� ������������ 
����� 	��� ������ ��

3. In the Select Insert File dialog box, select the section file that you want to
insert into the transport stream.

4. After you select the desired insert file, press the OK  bezel button. This
closes the Select Insert File dialog box and opens the Insertion Setup dialog
box shown in Figure 3-30.

5. The Insertion Setup dialog box lets you set the parameters for how the
section data will be inserted into the transport stream. Refer to Insertion
Setup Dialog Box on page 3-12 for information about the parameters.
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6. After you set the Insertion Setup dialog box parameters, press the Apply
bezel button to confirm the settings, close the dialog box, and start the
section data insertion.

When section data insertion starts, the icon representing the inserted data
appears at the end of the hierarchy display. The inserted-data icon is
displayed with a blue background.
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The MTG300 MPEG generator provides the capability to add jitter to PCRs
(Program Clock References). Adding jitter to PCRs allows you to simulate
transmission delay variations and to test the robustness of decoders under
various conditions.

The MPEG generator provides two types of jitter functions: Interval Jitter and
Value Jitter. Refer to Interval Jitter Function on page 3-90 and to Value Jitter
Function on page 3-92 for detailed information about the two jitter functions.


����� ��  ��

Perform the following procedure to add jitter to PCRs:

1. Use the Icon cursor to select the PCR item in the hierarchy display that you
want to replace. If the Icon cursor is not displayed, press the MENU  button
to enable the Icon cursor.

2. Press the Stress PCR... bezel button. This opens the PCR Stress dialog box
shown in Figure 3-31.

���!�� �$��	���� � ���� ������ ��"
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3. The PCR Stress dialog box lets you set how the parameters for how jitter
will be added to the PCR. The PCR Stress dialog box is divided into the
following two fields:

� Interval Jitter. Use this field to add jitter to the period of the transport
stream packets containing a PCR.

� Value Jitter. Use this field to add jitter to the program_clock_refer-
ence_base value and the program_clock_reference_extension value in the
adaptation field.

Refer to PCR Stress Dialog Box on page 3-51 for information about the
dialog box parameters. For detailed information about the two jitter
functions, refer to Interval Jitter Function on page 3-90 and Value Jitter
Function on page 3-92.

4. After you have set the parameters, press the Interval Apply  bezel button
and/or the Value Apply bezel button to enable one or both of the jitter
functions.

�������� 	����� �������

The Interval Jitter function, accessed through the PCR Stress dialog box (see
Figure 3-31), allows you to add jitter to the period of packets containing a PCR.
Refer to PCR Stress Dialog Box on page 3-51 for information about the dialog
box parameters.

The Interval Jitter function provides two function modes: Period and Deviation.
This subsection describes the differences between the two modes.

������ 
���� In this mode, amplitude variation of the waveform selected in
Pattern item is added to PCR interval currently set.

Figure 3-32 shows the variation of PCR interval in Period mode with following
settings:

PCR Interval: 30 ms, Pattern: Square, Period: 8 [Packets], Amplitude: 10 ms

In this mode, PCR interval after jitter insertion can be defined by the following
equation:

PCR(n) =PCR_Reference + �Square(t)

Where: PCR_Reference is the PCR interval set in the PCR Interval item, and 
Square(t) is the square waveform defined by the Amplitude and Period items.
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	�������� ����� In this mode, PCR interval varies by the amplitude variation of
the waveform selected in the Pattern item with reference to standard PCR
interval.

Figure 3-33 shows the variation of PCR interval in Deviation mode with
following settings:

PCR Interval: 30 ms, Pattern: Square, Period: 8 [Packets], Amplitude: 10 ms

In this mode, PCR interval after jitter insertion can be defined by the following
equation:

PCR(n) =PCR_Reference + Square(t)

Where: PCR_Reference is the PCR interval set in the PCR Interval item, and 
Square(t) is the square waveform defined by the Amplitude and Period items.
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The Value Jitter function, accessed through the PCR Stress dialog box (see
Figure 3-31), allows you to add jitter to the program_clock_reference_base value
and the program_clock_reference_extension value in the adaptation field of
transport stream packets. You can use this function to modulate the data values
of the PCRs away from their correct values. Refer to PCR Stress Dialog Box on
page 3-51 for information about the dialog box parameters.

Figure 3-34 shows the relationship among these parameters and how the PCR
values (program_clock_reference_base value and program_clock_reference_ex-
tension) change when Sine is selected as a jitter-pattern waveform. The PCR
values varies by the value of sine waveform defined by the amplitude and period.
The PCR period does not change.
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The MPEG generator provides the capability to save the user-defined instrument
settings on the hard disk as a preset file and load the instrument settings saved as
a preset file. This section describes the contents of the instrument settings saved
as a preset file and how to save and load a preset file.

The preset file has the extension of .set and save the /usr/preset directory on the
hard disk.

����. The preset file cannot be saved on a floppy disk directory. Also, it cannot
br loaded into the instrument’s memory from a floppy disk directory. If you want
to save a preset file to a floppy disk, first save the file to the hard disk, and then
copy it from the hard disk to the floppy disk by the Copy... command in the FILE
pull-down menu. Also, If you want to load a preset file stored in a floppy disk,
copy the file from the floppy disk to the hard disk by the Copy... command in the
FILE pull-down menu.

������ �	 �
� ������ ����

The preset file contains the following instrument settings:

� File name and parameter settings of the insertion file(s) and replace file(s).

� Packet size, clock mode, clock rate, output level, parallel/serial output
format, and ASI output format.

� Output loop mode, initial value of the PCR, TDT/TOT/STT update mode,
and auto play on power up mode.

� Information of the deleted transport stream item (packet), start/end packet of
the transport stream.

� Network parameters.
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This subsection provides the procedures to save the current instrument settings
on the hard disk as a preset file.

Perform the following steps to save a preset file:

1. Set the instrument settings that you want to save.

2. Select Save Preset... from FILE pull-down menu, and then press the OK
bezel button. This opens the Input Preset Filename dialog box shown in
Figure 3-35.

������ ����������� 	����� �������� ����� ���

3. In the dialog box, enter the file name that you want to use as the preset file.
The *.set extension is added automatically.

4. After you have completed the text input, press the OK  bezel button.



Preset File

MTG100 & MTG300 MPEG Generator User Manual ����

������� � 	����� ����

This subsection provides the procedures to load an instrument settings saved as a
preset file.

����. When you load the preset file contained the information of the insertion
file(s) and replace file(s), the appropriate file(s) must be resided on the hard disk
of the MPEG generator. If the appropriate file(s) is(are) not resided on the hard
disk, the settings of the preset file are not reproduced exactly.

Perform the following steps to load a preset file:

1. Select Load Preset... from FILE pull-down menu, and then press the OK
bezel button. This opens the Select Preset File dialog box shown in 
Figure 3-36.

������ ������
���� 	����� ���� ������ ���

2. In the dialog box, select the preset file that you want to load, and then press
the OK  bezel button.
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You can view (and edit) a preset file with a text editing application such as
Notepad. An example of a preset file is shown below.
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This section explains the following file operations used in the MPEG generator:

� Creating a new folder

� Copying a file

� Deleting a file or folder

� Renaming a file name or folder name

Refer to Preset File beginning on page 3-95, how to save and load a preset file.

��
���� 
 �� �����

����. You cannot create a new folder (subdirectory) in the same hierarchy as
that of the insert, preset, and ts folders (directories) on the main drive (hard disk
drive).

Perform the following procedures to create a new folder (subdirectory):

1. Select New folder... from FILE pull-down menu, and then press the OK
bezel button. This opens the Input new folder name dialog box shown in
Figure 3-37.

����� ����������� �� ����� �
� ��
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2. Press the Drive... bezel button to open the Select Drive dialog box shown in
Figure 3-38.

	����� ������
���� ����� ������ ���

3. Select the drive (Main or Floppy) in which you want to create a new folder,
and press the OK  bezel button.

4. Use the down arrow button to highlight the Filename column in the Input
new folder name dialog box, .

5. Use the rotary knob and the Down Level bezel button to select the directory
under which you want to create a new folder.

6. Use the up arrow button to highlight the text input field in the Input new
folder name dialog box.

7. Enter the new folder name in the text input field, and then press the OK
bezel button,

������� � ����

����. You cannot copy a stream file.

Perform the following procedures to copy a file:

1. Select Copy... from FILE pull-down menu, and then press the OK  bezel
button. This opens the File copy dialog box shown in Figure 3-39.

When you access the dialog box first, the Source field and Destination field
are empty.
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2. Press the Source... bezel button to open the Select source file dialog box.

3. Press the Drive... bezel button to open the Select Drive dialog box.

4. In the dialog box, select the source drive (Main or Floppy), and press the
OK  bezel button.

5. Use the rotary knob and the Down Level bezel button to select the source
file, and then press the OK  bezel button.

6. Press the Destination... bezel button to open the Input destination file
name dialog box.

7. If the destination drive is different from the source drive, press the Drive...
bezel button to open the Select Drive dialog box.

8. In the dialog box, select the destination drive (Main or Floppy), and press
the OK  bezel button.

9. In the Input destination file name dialog box, enter the destination file
name. In the text input field, the source file name appears. After you have
completed the text input, press the OK  bezel button.

10. Confirm the drive name and path name in the Source and Destination fields,
and then press the Execute button.
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����. You cannot delete the insert, preset, or ts folder on the main drive (hard
disk drive). Also, you cannot delete the folder which contains some files.

Perform the following procedures to delete a file or folder:

1. Select Delete... from FILE pull-down menu, and then press the OK  bezel
button. This opens the Select file dialog box.

2. Press the Drive... bezel button to open the Select Drive dialog box.

3. In the dialog box, select the drive (Main or Floppy) which contains the file
or folder that you want to delete, and press the OK  bezel button.

4. Use the rotary knob and the Down Level bezel button, select the file or
folder that you want to delete, and then press the OK  bezel button.

This displays a pop-up message box to confirm the delete operation.

5. Press the OK  bezel button to execute the operation.


������� � ���� ���� �� ����� ����

����. You cannot rename the insert, preset, or ts folder name on the main drive
(hard disk drive).

Perform the following procedures to rename a file name or folder name:

1. Select Rename... from FILE pull-down menu, and then press the OK  bezel
button. This opens the Rename file dialog box shown in Figure 3-40.

	����� ������
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2. Press the Old file name... bezel button to open the Select file dialog box.

3. Press the Drive... bezel button to open the Select Drive dialog box.

4. In the dialog box, select the drive (Main or Floppy) which contains the file
or folder that you want to rename, and press the OK  bezel button.

5. Use the rotary knob and the Down Level bezel button, select the file or
folder that you want to rename, and then press the OK  bezel button.

6. Press the New file name... bezel button to open the Input new file name
dialog box.

7. In the dialog box, enter the new file name or folder name, and then press the
OK  bezel button.

8. Confirm the old file name and new file name in the Rename file dialog box,
and then press the Execute bezel button.
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This section is divided into two subsections. General Characteristics lists the
functional, electrical, mechanical, and environmental characteristics of the
MPEG generator. Certifications and Compliances lists the national and
international standards to which the MPEG generator complies.

�����	� ��	�	
�������
�

This section lists the functional, electrical, mechanical, and environmental
characteristics of the MPEG generator.

All listed specifications are guaranteed unless labeled with “typical”. Typical
specifications are provided for your convenience but are not guaranteed.

The electrical characteristics listed on the following pages are valid under the
following conditions:

� The MPEG generator must be in an environment where the temperature,
altitude, humidity, and vibration conditions are within the operating limits
described in Table A-4 on page A-8.

� The MPEG generator must have a warm-up period of at least 20 minutes.

� The MPEG generator must have been calibrated and adjusted at an ambient
temperature between +20� C and +30� C.

� The MPEG generator must be operating at an ambient temperature between
+5� C to +40� C, unless otherwise noted.

������	�
� ����������
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This subsection lists the national and international standards to which the MPEG
generator complies.
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MTG Comm+, a standard accessory with the MPEG generator, is a software
application for a PC using the Microsoft Windows 95/98/2000/NT operating
system. MTG Comm+ provides the capability to transfer stream, insertion, or
preset files between a PC and the MPEG generator using the Ethernet interface.

This section provides the following information:

� Minimum system requirements for your PC

� Instructions for installing MTG Comm+ on your PC(s) and connecting the
MPEG generator to your Ethernet network

� Instructions for operating the MTG Comm+ application including the
requirements for transferred files

� Tutorials for transferring files between a PC and the MPEG generator

� �%!"�� ���#� ����"!

Your PC requires the following minimum system requirements to load and
operate the MTG Comm+ application:

� Microsoft Windows 95/98/2000/NT operating system

� Ethernet interface

��!"����"��� ��!" #�"���! ��� �"�� ��" ��"#�

This subsection provides the following instructions: installing the MTG Comm+

application on your PC, creating a desktop shortcut icon on the PC to run
MTG Comm+, connecting your PC(s) to the MPEG generator using the Ethernet
port, and setting the required Ethernet parameters.

����. Before you install the MTG Comm+ application on your PC, create a
back-up copy of the original MTG Comm+ software disk supplied with the
application. Store the original disk in a safe location and use the copy disk to
perform the installation procedure. After you complete the MTG Comm+

installation procedure, store the back-up disk in a safe location for future use.
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The following installation instructions assume that you are familiar with the
basics of using the Windows operating system. If necessary, read your Windows
user documentation before installing MTG Comm+.

Perform the following procedure to install MTG Comm+:

1. Be sure that your PC meets the requirements listed under PC System
Requirements on page B-1 before proceeding with the installation.

2. Insert the MTG Comm+ installation disk into a 3.5 inch floppy disk drive on
your PC, and then double-click the My Computer icon on your PC.

3. Click on the 3.5 inch floppy drive icon that you are using for the installa-
tion. The PC will display the contents of the MTG Comm+ installation disk.

�������� To prevent data loss, it is strongly recommended than you exit any
open applications on your PC before you run the MTG Comm+ Setup.exe file.

4. Double-click Setup.exe in the list. The MTG Comm+ installation program
will display a series of setup windows as listed below. Click the Next>
button to accept the default parameters or change the parameters in the setup
windows to suit your needs. Click the <Back button in a setup window to
return to the previous setup window.

a. Welcome window. Read the displayed information, and then click the
Next> button to proceed with the installation.

b. Choose Destination Location window. The default directory location for
the application is displayed. If you want to install MTG Comm+ in a
custom location, click the Browse... button, and then select or create a
custom directory location. Click the Next> button to proceed.

c. Select Program Folder window. The default name for the program folder
is displayed. If you want to change the name, type in a new name or
select a name from the Existing Folders list. Click the Next> button
to proceed.

d. Start Copying Files window. Review the displayed information, and then
click the Next> button to start the installation.

e. Setup Complete window. If the installation is successful, you will see a
message that Setup has finished installing the MTG Comm+ application
onto your PC. If you want to run MTG Comm+ immediately, select
Yes, Launch the program file, and then click the Finish button. To
exit the installation program without running MTG Comm+, click the
Finish button.

5. Remove the MTG Comm+ installation disk from your PC, and then store the
disk in a safe location.

����
��� �	�������
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Perform the following procedure to create an icon on your PC desktop that you
can use to run the MTG Comm+ application:

1. On your PC display, move the mouse cursor to any unoccupied desktop area,
and then click the right mouse button to open the desktop menu.

2. From the desktop menu select New, and then select Shortcut to open the
Create Shortcut dialog box.

3. Click the Browse... button in the Create Shortcut dialog box.

4. Use the Browse dialog box to locate the MTG Comm+ directory.

a. If you installed the MTG Comm+ application using the default directory
location and the default folder name in the installation procedure, select
the following directory folders in order: Program Files, Sonytek, and
MTG Comm+ 2.0.

b. If you installed the MTG Comm+ application to a custom location or
gave the application folder a custom name, you will need to select your
custom directory path.

c. You should now be at a location in the PC directory structure where the
browse list box shows the MTG Comm+ Sample folder and the
MtgComm+.exe file.

5. Select the MtgComm+.exe file (MtgComm+.exe will be displayed in the file
name box), and then click the Open button. The directory path to the
MtgComm+.exe file will now be displayed in the Comm and Line box of the
Create Shortcut dialog box.

6. Click the Next> button in the Create Shortcut dialog box. The default name
of the shortcut icon is now displayed in the dialog box. You can edit the icon
name to suit your needs or accept the default name.

7. Click the Finish button to finish creating the desktop shortcut icon. The
Mtgcomm+.exe shortcut icon will now appear on the PC desktop. You can
start the MTG Comm+ application by double-clicking the MtgComm+.exe
(or your custom name) shortcut icon.

��
���� � �
�����
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MTG Comm+ uses the rear-panel Ethernet port on the MPEG generator to
communicate with a PC (see Figure 2-2 on page 2-4) using 100BASE-T. Use one
of the following two methods to connect your PC(s) to the MPEG generator:

� If you are connecting the MPEG generator directly to a single PC, use a
100BASE-T crossover Ethernet cable to connect between the Ethernet port
on the MPEG generator and the Ethernet port on the PC. If you need to
construct your own crossover cable, Figure B-1 shows the pin connections to
change on a straight cable to produce a crossover cable.

� If you are connecting the MPEG generator to your local Ethernet network,
use a straight Ethernet cable to connect between the Ethernet port on the
MPEG generator and the Ethernet hub port of your local network. By
connecting to an Ethernet network, you can access the MPEG generator
using any PC on the network running the MTG Comm+ application.

�
� � 	�

�
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�
� �� ��
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Before you can use MTG Comm+ to transfer files between the MPEG generator
and your PC(s), you must set the Ethernet network parameters for both the
MPEG generator and the MTG Comm+ application.

����. Use the ping command from the PC and the Ping command from the
MPEG generator (available when the Network dialog box is displayed) to verify
network communications after you set the Ethernet network parameters for the
MPEG generator and for the MTG Comm+ application.

You must exit the Network dialog box before your network setting changes will
take effect.
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��	 	�������� Perform the following procedure to
set the Ethernet network parameters for the MPEG generator:

1. Select Network... from the Utility  pull-down menu on the MPEG generator.
This will open the Network dialog box shown in Figure B-2.

The settings you enter in the Network dialog box depend on how you
connect the MPEG generator to the remote PC. You can connect the MPEG
generator directly to a single PC or you can connect it to your local Ethernet
network.

������ � ���������� ����� ��� ��� ��� 
��	 ��������

2. If you connect the MPEG generator directly to a single PC, perform the
following steps to set the Network dialog box parameters:

a. Set the DHCP Client parameter to Disable.

b. Set the IP Address parameter to be the same IP address as the PC’s
address except for the last number. The last number must be different
than the last number in the PC’s IP address.

c. Set the Subnet Mask parameter to be the same subnet mask used by the
PC. Do not enter a number if the PC does not have a subnet mask.

d. You do not need to enter a Routing Destination or Routing Gateway if
you are directly connected to a single PC.
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3. If you connect the MPEG generator to your local Ethernet network, perform
the following steps to set the Network dialog box parameters:

� When a DHCP server is in the network.

If the DHCP server is in the network, when you select Enable in the
DHCP Client item, the MPEG generator functions as a DHCP client. In
this case, you can register the addresses such as the IP address and
subnet mask used by the MPEG generator. This way, the MPEG
generator accesses the DHCP server and gets the addresses automatically
when connected to the network.

����. Under some network environments, the MPEG generator may not be able
to get the IP address automatically from a DHCP server. In this case, you need
to enter the appropriate address value in each item.

� When a DHCP server is not in the network, see the Caution note below.

��	����� To prevent communication conflicts on your Ethernet network, ask
your local network administrator for the correct numbers to enter in the Network
dialog box if you connect the MPEG generator to your local Ethernet network.

4. Verify that the Ethernet connections using the ping command from the PC
and the Ping command from the Bezel menu of the Network dialog box.

	 ����� ������ ��� ��� �� ������ Perform the following procedure to set the
Ethernet network parameters for the MTG Comm+ application:

1. Select Network from the Utility  menu of the MTG Comm+ application.
This will open the Set MTG Host Name dialog box shown in Figure B-3.

2. Use the Host Name field in the dialog box to enter the IP address that you
assigned to your MPEG generator.

3. Click the OK  button to accept the settings and close the dialog box.
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This section describes the basics of operating the MTG Comm+ application. The
following information is located in this section:

� Requirements for transport stream files

� Instructions on how to start and exit the MTG Comm+ application

� Descriptions of the elements in the application window

� Descriptions of the functions available through the pull-down menus

� Tutorials containing procedures that show you how to transfer files between
your PC and the MPEG generator

�������� The MPEG generator comes from the factory with sample files loaded
on the hard drives. To prevent the loss of these files, it is recommended that you
use MTG Comm+ to save copies of these files.

�������� ����� ���� 
�����������

MTG Comm+ can transfer three types of files: stream files, insertion files, and
preset files (must have file extensions of .set).

When you download a file from the PC to the MPEG generator, you must
transfer the file to the correct folder in the MPEG generator, depending on the
type of file. Stream files must be transferred to the /main/usr/ts directory,
insertion files must be transferred to the /main/usr/insert directory, and preset
files must be transferred to the /main/usr/preset.

Refer to the Caution note on the following page before you transfer files using
MTG Comm+.
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�������� To prevent the transfer of bad data to the MPEG generator, be sure to
select and enter the correct parameters in the User Check dialog box. Entering
incorrect parameters, such as an incorrect format standard, will result in files
that cannot be transferred or will not be able to be properly played out from the
MPEG generator. Observe the following operating conditions:

Do not press the keyboard Enter key when you are entering values in the
Data Rate portion of the User Check dialog box. MTG Comm+ calculates the
Data Rate fields from your entered values after you leave an edited Data Rate
parameter. (You can see the Data Rate values change when you click on another
parameter.) If you press the Enter key before you exit an edited Data Rate
parameter, MTG Comm+ will download the transport stream file using an
incorrect data rate value.

	������ ��� ������ �
� �����

When you complete the installation procedure, you can use any of the following
methods to start the MTG Comm+ application:

� Double-click the MtgComm+ shortcut icon on the PC desktop that you
created during the installation procedure.

� Double-click the MtgComm+.exe file name in the Program Manager
window.

� Select MtgComm+ from the Start – Programs menu.

To exit (quit) the MTG Comm+ application, select Exit  from the File menu
command list of the application.
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Figure B-4 shows the MTG Comm+ application window. Table B-1 provides a
description of the elements in the application window.
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The Menu bar displays the names of the five pull-down menus: File, View,
Remote, Utility, and Help. This section describes the function of each selection
in these menus.

The File menu contains commands for managing file operations and for exiting
the MTG Comm+ application. Table B-3 describes each of the File menu
commands.
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���� ����� 	����� ���� The User Check dialog box (see Figure B-5) appears after
you click the Open button in the Open File dialog box when you are transferring
a file from the PC to the MPEG generator. Table B-4 describes the User Check
dialog box parameters.

�������� Refer to Transport Stream File Requirements on page B-7 for
important information about the requirements of the transport stream files
downloaded using this dialog box. Be sure to read the Caution note on
page B-8 before you operate the User Check dialog box.


����� ��������� ����� ������ ��



Appendix B: Using MTG Comm+ for File Transfers

���� MTG100 & MTG300 MPEG Generator User Manual

	���� �����
��� ���� ������ ��� �����������

��������� ����������

�*,& �*20,"82 3)& %*1&$3/18 0"3) ".% '*,& ."-& /' 3)& 231&"- '*,& 8/4 2&,&$3&% 3/
31".2'&1 3/ 3)& ���� (&.&1"3/1�

�*,& �*9& �*20,"82 3)& '*,& 2*9& /' 3)& 231&"- '*,& 8/4 2&,&$3&% 3/ 31".2'&1 3/ 3)&
���� (&.&1"3/1�

�3".%"1% �&32 3)& '/1-"3 3/ #& 42&% #8 3)& ���� (&.&1"3/1 3/ 0,"8#"$+ 3)& 231&"-
'*,& 8/4 "1& 31".2'&11*.( 3/ 3)& (&.&1"3/1� !/4 -423 2&3 3)*2 0"1"-&3&1 3/
$/11&$3,8 -"3$) 3)& '/1-"3 /' 3)& 2&,&$3&% 31".20/13 231&"- '*,& /1 &,2& 3)&
���� (&.&1"3/1 6*,, ./3 #& "#,& 3/ $/11&$3,8 0,"8#"$+ 3)& '*,&� �&'&1 3/ 3)&
������� ./3& /. 0"(& �:��

�/1 " �/. ��� �:����� /1 �:���� '*,&� 3)& 23".%"1% *2 %&3&1-*.&%
"43/-"3*$",,8 #8 3)& "00,*$"3*/. %&0&.%*.( /. 3)& '*,& $/.3&.3� �/1 "
31".20/13 231&"- '*,& �����	� ����� ���� /1 ������ 3)& 23".%"1% *2 2&3
3/ 3)& 01&5*/42 2&33*.( "2 " %&'"4,3�

�' 3)& �/. �� 23".%"1% *2 2&,&$3&%� 3)& �28.$ #433/. #&$/-&2 5",*%�
 )&. 8/4 01&22 3)*2 #433/.� 3)& �&3 �28.$ %*",/( #/7 "00&"12� �2& 3)&
%*",/( #/7 3/ &."#,& 3)& ��!�� ".% ������ 2*(.", '/1 %"3" /43043� �&'&1
3/ ��� ����	 ����� ��� /. 0"(& �:�� '/1 %&3"*,&% *.'/1-"3*/. "#/43 3)&
%*",/( #/7 0"1"-&3&12�

�&'&1 3/ ��������	 ������������� �� ����
��
 /. 0"(& �:	
 "#/43 )/6
3)& ��� �/--� "00,*$"3*/. %&3&1-*.&2 3)& 23".%"1% /' 3)& 2&,&$3&%
231&"- '*,&�

�"$+&3 �*9& �&32 3)& 0"$+&3 2*9& /' 3)& 2&,&$3&% 31".20/13 231&"-� �)& ��� �/--�

"00,*$"3*/. "43/-"3*$",,8 2&32 3)*2 0"1"-&3&1 3/ -"3$) 3)& 2&,&$3&%
31".20/13 231&"- '*,&� �)& "00,*$"3*/. $/4.32 3)& .4-#&1 /' #83&2 #&36&&.
3)& �7� �28.$ #83&� 5",4&2 *. 3)& 231&"-�



Appendix B: Using MTG Comm+ for File Transfers

MTG100 & MTG300 MPEG Generator User Manual 	!��

���� 	!������� 
���� ������ �� ������������
�����

��������� �����������

��+� ��+� ��+* +!� ����,$+ �$'�# )�+� ,*�� �0 +!� ����  �&�)�+') +' ($�0���# +!�
*+)��%� �!� ��� 
'%%� �(($"��+"'& �&�$01�* +!� *�$��+�� *+)��% �&�
�,+'%�+"��$$0 �(()'/"%�+�* +!� ��+� )�+�� �', ��& �&+�) -�$,�* "& +!�
�)��+"'& �"�$�* +' ()'-"��  )��+�) �$'�# ���,)��0�

�', ��& ,*� +!� (��#�+ *"1� �'/ +' !�-� +!� ����  �&�)�+') ($�0���#
+!� +)�&*(')+ *+)��% �"$� ."+! � *(��"�"�� (��#�+ *"1� +!�+ "* �"���)�&+ +!�&
+!� ')" "&�$ �"$��

��+�) 0', �&+�) -�$,�* "& +!� ��+� ��+� �"�$�*� �' &'+ ()�** +!� #�0�'�)�
�&+�) #�0� ����) +' +!� ������� &'+� '& (� � 	3��

�)"-�+� ���+"'&
���"&"+"'& "$�

�(��"�"�* +!� �"$� ��*�)"�"& +!� ��� �&� +��$��"� -�$,�* '� +!�
()"-�+��*��+"'&� �� +!� *�$��+�� +)�&*(')+ *+)��% �"$� �'&+�"&* +!� +)�&*(')+
*+)��% (��#�+ ."+! +!� ��� �&� +��$��"� -�$,� ��*�)"��� "& +!� ()"-�+�
*��+"'& ���"&"+"'& �"$�� +!� (��#�+ �((��)* "& +!� !"�)�)�!0 �"*($�0 �* �
����"�'&�

�*� +!� �'$$'."& �')%�+ +' ��*�)"�� +!� ()"-�+� *��+"'& ���"&"+"'& �"$��

��
� �������� ������	

�!� �'$$'."& "* �& �/�%($� '� +!� ()"-�+� *��+"'& ���"&"+"'& �"$� "& +!�
!�/����"%�$ -�$,��

�����������
���������

�
�

�', ��& �")��+$0 ��*�)"�� +!� �"$� &�%� "& +!� +�/+ �'/� �!�& 0', �$"�# +!�
��"+ �,++'&� 0', ��& ��"+ +!� �"$� ,*"& +!� +�/+ ��"+') *(��"�"�� �0 +!�
�(+"'&* �'%%�&� '� +!� �+"$"+0 (,$$3�'.& %�&,� �!�& 0', �$"�# +!� 2����
�,++'&� +!� �(�&�"$� �"�$' �'/ '(�&* .!�)� 0', ��& *�$��+ �&'+!�)
()"-�+� *��+"'& ���"&"+"'& �"$��



Appendix B: Using MTG Comm+ for File Transfers

���� MTG100 & MTG300 MPEG Generator User Manual

��� 
���� ����� ����  The Set Psync dialog box (see Figure B-6) appears after
you click the Psync button in the User Check dialog box. Table B-5 describes the
Set Psync dialog box parameters.
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The View menu contains commands that control the appearance of the
MTG Comm+ application window. Table B-6 describes each of the View menu
commands.
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The Remote menu contains commands that load the transport stream file or
preset file and control the data output of the MPEG generator. Table B-6
describes each of the Remote menu commands.
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The Utility menu contains commands for setting the network parameters.
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��� ������� ������ �� �  The Set Options dialog box (See Figure B-7) appears
after you select Options command in the Utility menu. Table B-9 describes the
Set Option dialog box parameters.

	����� �!������ ������� ������ �� 
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The Help menu About... command displays information including the
MTG Comm+ software version number and copyright information.
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After you have connected the MPEG generator to the PC using an Ethernet cable
and set the required network parameters, you can use MTG Comm+ to transfer
files between the PC and the MPEG generator.

����. The convention used by the MTG Comm+ application is to call file
transfers from the PC to the MPEG generator a “download,” and to call file
transfers from the MPEG generator to the PC an “upload.”

This subsection provides the procedures to download a stream file, an insertion
file, or a preset file from the PC to the MPEG generator.

������ 
���� Perform the following steps to download a stream file from the PC
to the MPEG generator:

1. Select PC to MTG... from the File pull-down menu to open the PC to MTG
Download dialog box.

2. In the PC to MTG Download dialog box, highlight the stream file on the PC
that you want to download, and then click the Download button to open the
User Check dialog box shown in Figure B-5 on page B-13.

��	����� Refer to Transport Stream File Requirements on page B-7 for
important information about the requirements for transport stream files you may
want to transfer. Be sure to read the Caution note on page B-8 before you
operate the User Check dialog box.

3. Select the desired parameters in the User Check dialog box, and then click
the OK  button to download the file. Refer to User Check Dialog Box on
page B-13 for more information.

����. You can download more than one stream file from the PC to the MPEG
generator using drag-and-drop operation.

����������� � 
��� �� ���

�	� ���������
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��������� ����� Perform the following steps to download an insertion file from the
PC to the MPEG generator:

1. Select PC to MTG... from the File pull-down menu to open the PC to MTG
Download dialog box.

2. In the PC to MTG Download dialog box, highlight the insertion file on the
PC that you want to download, and then click the Download button to open
the Insert File dialog box shown in Figure B-8.

�������� Refer to Transport Stream File Requirements on page B-7 for
important information about the requirements for transport stream files you may
want to transfer.

3. In the Insert File dialog box, confirm the insertion file than you want to
download to the MPEG generator by clicking the OK  button to download
the file.


����� � ����� 	���� ������ 
��� ������ ���

������ ����� Perform the following steps to download a preset file from the PC to
the MPEG generator:

1. Select PC to MTG... from the File pull-down menu to open the PC to MTG
Download dialog box.

2. In the PC to MTG Download dialog box, highlight the preset file on the PC
that you want to download, and then click the Download button to open the
Insert File dialog box shown in Figure B-9.

�������� Refer to Transport Stream File Requirements on page B-7 for
important information about the requirements for transport stream files you may
want to transfer.

3. In the Preset File dialog box, confirm the preset file that you want to
download.
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4. When you click the Edit  button, you can view the content of the preset file
and edit it.

5. Click the OK  button to download the file.

������ �����
�	 ����� ������ ���� ������ ���

The procedure for uploading a file from the MPEG generator to the PC is the
same for a stream file, an insertion file, and a preset file.

Perform the following steps to upload a stream file, an insertion file, or a preset
file from the MPEG generator to the PC:

1. In the List view of the MTG Comm+ application, select the file you want to
upload to the PC.

2. Select MTG to PC... from the File pull-down menu to open the MTG to PC
Upload dialog box.

3. In the MTG to PC Upload dialog box, specify the destination folder for the
file you are going to upload to your PC.

4. Click the Upload button to upload the file from the MPEG generator to your
PC.

�������� � ���� �� ��� ��
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MTG Comm+ automatically determines the standard of the selected stream file
using the procedures shown in Figures B-10 and B-11.

In general, it is recommended to use the standard selected as the result of the
automatic determination. If you change the standard as shown below, the stream
file may not be analyzed correctly.

� From Non TS to a standard other Non TS

� From MPEG2, ATSC, DVB, or ARIB to S-TMCC or M-TMCC

� From M-TMCC to MPEG2, ATSC, DVB, or ARIB

If more than 650 stream items (icons) ware recognized in the stream file, no
further icon may be created.

When you click the Check ISDB_S option in the Set Option dialog box (See
Figure B-7 on page B-19) to off, you can skip the file check procedure for the
M-TMCC and S-TMCC files.

�������	 �����������

�� ����
��
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�������� �������� ��� 	���� ����������

ReMux is the application software that can be accessed from the toolbar of the
MTG Comm+ application. ReMux provides the capability to create a transport
stream of super frame structure defined in the ISDB-S system from a MPEG2
transport stream.

This section describes the functions of the ReMux application and how to create
a transport stream of super frame structure.

Refer to Appendix B: Using MTG Comm+ for File Transfers for detailed
information about the MTG Comm+ application.

����. The ReMux application cannot handle files larger than 2 GB.


������� ��� 	���� ����������

Click the ReMux icon in the toolbar of the MTG Comm+ application window to
start the application.

���	
 ����
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������ �� �� ���� 	�����

Figure C-2 shows the ReMux application window. Table C-2 provides a
description of the elements in the application window.
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The Menu bar displays the name of the six pull-down menus: File, Edit, View,
ReMux, Window, and Help. This section describes the function of each selection
in these menus.

The File menu contains commands for managing file operations and for exiting
the ReMux application. Table C-3 describes each of the File menu commands.
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������ ����� 
��� ������ ����  The Select Remux Mode dialog box (see Figure
C-3 ) appears after you select the New command in the File menu. Select one of
the ReMux mode, and then click the OK  button. Table C-4 describes the Select
Remux Mode dialog box parameters.
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The Edit menu contains commands that control TMCC information display and
add/delete TMCC information and transport stream. Table C-5 describes each of
the Edit menu commands.
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The ReMux menu contains commands that execute the selected operation, select
a ReMux mode, and select option settings. Table C-6 describes each of the
ReMux menu commands.
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����� 	����� ��$�  The OPTION dialog box (see Figure C-4) appears after you
select the Option command in the ReMux menu. Table C-4 describes the Select
Remux Mode dialog box parameters.
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The Window menu contains commands that control the appearance of the editing
windows and open the new window. Table C-8 describes each of the Window
menu commands.
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The View menu contains commands that control the appearance of the ReMux
application window. Table C-9 describes each of the View menu commands.
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The Help menu About ReMux... command displays information including the
ReMux software version number and copyright information.

	���� ��������

This subsection describes the basics of operating the ReMux application.

This mode allows you to create a transport stream of S-TMCC structure from a
transport stream.

This subsection describes the procedure to create a transport stream of S-TMCC
structure from a transport stream.

1. Select New from the File pull-down menu or click the New button on the
toolbar to open the Select Remux Mode dialog box shown in Figure C-3 on
page C-5.

2. Select Make S-TMCC TS in the dialog box, and then click the OK  button
to open the editing window for the Make S-TMCC TS mode shown in 
Figure C-5.
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The information displayed at the right side of the TMCC icon has following
meaning:
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3. Select Add from the Edit  pull-down menu or clock the + (Add) button on
the toolbar to open the Open dialog box.

4. In the dialog box, select a transport stream file, and then click the Open
button to open the Edit TS Information  dialog box shown in Figure C-6.
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In this dialog box, you can set the following parameters:

� File: Specifies the transport stream file to be converted to a transport stream
file of S-TMCC structure.

� Data Rate: Specifies the data rate of the transport stream. You cannot set the
value exceed the data rate of the effective slots. If this value is less than the
data rate of the effective slot, in addition, conversion of the data rate is done
with the insertion of null packets.

� Contract Slots: Shows the number of contract slots. This value depends on
the number of slots set in the Modulation item.

� Modulation : Specifies the modulation system and the number of slots to be
assigned to HQ and LQ when performed hierarchical data transfer.

� HQ: Specifies the modulation system and the number of slots to be
assigned to HQ level.

� LQ : Specifies the modulation system and the number of slots to be
assigned to LQ level. This field is enabled only when the hierarchical
control descriptor exists in PMT.

� TS ID: Specifies the transport stream ID.  This value is used to change the
ID value in TMCC, and the ID value in PAT is not changed.
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� Initial Delay : Specifies the number of delay packets (i.e., null packets) to be
inserted at the start of re-multiplex. You can set the value in the range of 0 to
65535.

5. After you change the parameters, click the OK  button to confirm the changes
and close the dialog box.

This displays a transport stream icon under the TMCC icon (See 
Figure C-7).
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The information displayed at the right side of the transport stream icon has
following meaning:
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6. Double-click the TMCC icon to open the Edit TMCC Information  dialog
box to edit the TMCC information for the transport stream (See Figure C-8).

���!�� 	#���
�� �		 ������� ��� ������ ��" ��#�		�

In this dialog box, you can set the following parameters:

� Transmitter/Receiver Control Information : Sets the transmission/receiv-
ing control information.

� Switch On Control Signal: Sets the start control signal to on (1) or 
off (0).

� Reserve: Sets the reserve bit.

7. After you change the parameters, click the OK  button to confirm the changes
and close the dialog box.

	��� ��� � �������� � ���� �� �#�		 � �!� !���

8. Select Execute in the ReMux pull-down menu or click the � (Execute)
button to open the Save As... dialog box.

9. In the dialog box, specify a file name, and then click the Save button.
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This mode allows you to create a transport stream of M-TMCC structure from a
transport stream of S-TMCC structure.

This subsection describes the procedure to create a transport stream of M-TMCC
structure from a transport stream of S-TMCC structure.

1. Select New from the File pull-down menu or click the New button on the
toolbar to open the Select Remux Mode dialog box shown in Figure C-3 on
page C-5.

2. Select ReMux to M-TMCC TS from S-TMCC TS  in the dialog box, and
then click the OK  button to open the editing window for the ReMux to
M-TMCC TS from S-TMCC TS mode shown in Figure C-9.
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3. Select Add from the Edit  pull-down menu or click the + (Add) button on the
toolbar to open the Open dialog box.

4. In the dialog box, select a transport stream file having S-TMCC structure,
and then click the Open button to open the Edit TS Information  dialog box
shown in Figure C-6 on page C-10.

����. If you select a transport stream file having no S-TMCC structure, an error
message appears.
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5. In the dialog box, set the parameters, and then click the OK  button. This
displays a transport stream icon in the window.

	����������� ��������� 
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In the ReMux to M-TMCC TS from S-TMCC TS mode, you can multiplex
transport streams of S-TMCC structure until the total number of slots reached to
48.

6. Select Add from the Edit  pull-down menu or click the + (Add) button on the
toolbar to open the Open dialog box.

7. In the dialog box, select a transport stream file having S-TMCC structure,
and then click the Open button to open the Edit TS Information  dialog box
shown in Figure C-6 on page C-10.

8. In the dialog box, set the parameters, and then click the OK  button.

This multiplexes the newly selected transport stream and the transport stream
icon is added in the window (See Figure C-10).

������ ��������������� ������ �� ����������

9. If you want to multiplex more transport streams, repeat steps 6 through 8.
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10. Double-click the TMCC icon to open the Edit TMCC Information  dialog
box for editing the TMCC information for the transport stream (See 
Figure C-11).
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In this dialog box, you can set the following parameters:

� Order of Change: Sets the TMCC change instruction. You can set the value
in the range of 0 to 31.

� Transmitter/Receiver Control Information : Sets the transmission/receiv-
ing control information.

� Switch On Control Signal: Sets the control signal on (1) or off (0).

� Up-Link Control : Controls the up-link switching.

� Extended Information: Sets the extended information. When you set the
Flag ( extension flag) item to 1, the Field item becomes active.

11. After you change the parameters, click the OK  button to confirm the changes
and close the dialog box.
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12. Select Execute in the ReMux pull-down menu or click the � (Execute)
button to open the Save As... dialog box.

13. In the dialog box, specify a file name, and then click the Save button.

If the number of slots of the transport stream of M-TMCC structure you are
going to create is less than 48, a dummy transport stream(s) is(are) inserted
so that the number of slots reached to 48. The transport stream thus inserted
has the ID value set in the OPTION dialog box (See Figure C-4 on page
C-7) and TS8PSK is used as the modulation system.

� ������"��� ��������� ������ �� �#���� �� �� �� !��� 	�������� ����

������������

In the ReMux to M-TMCC TS from S-TMCC TS mode, you can multiplex a
transport stream of M-TMCC structure with a transport stream of M-TMCC
structure having different TMCC information.

14. Click the TMCC icon.

15. Select the Add command from the Edit  pull-down menu or click the +
(Add) button on the toolbar to open the Add TMCC  dialog box as shown in
Figure C-12.
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In this dialog box, you can specify the transport stream to which the new TMCC
information is inserted if more than one transport stream is multiplexed.

The following illustration shows the positional relationship of TMCC informa-
tion and the transport stream to be inserted to the transport streams already
multiplexed.
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This illustration shows the positional relationship when inserted TMCC
information and the transport stream 3 after the transport stream 1 while two
transport streams have been multiplexed. The new TMCC information is
inserted to the position two frames before the location to which the transport
stream to be newly multiplexed is inserted.

16. In the Add TMCC dialog box, select a transport stream number, and then
click the OK  button to open the Edit TMCC Information  dialog box for
editing the TMCC information (See Figure C-11).

17. After you change the parameters, click the OK  button to confirm the changes
and close the dialog box.

This opens a new editing window with a TMCC icon displayed. In this case,
note the increase of the value indicating change instruction at the right side
of the TMCC icon. In addition, the First  and Previous buttons on the
toolbar change their color to green indicating that a TMCC exists before this
TMCC.

18. Repeat steps 3 through 5 to select a transport stream file.

19. Repeat steps 6 through 8 to multiplex the transport stream file.

20. If you want to further multiplex a transport stream(s) of M-TMCC structure
having different TMCC information, repeat steps 14 through 19.
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21. Select Execute in the ReMux pull-down menu or click the � (Execute)
button to open the Save As... dialog box.

22. In the dialog box, specify a file name, and then click the Save button.

If the number of slots of the transport stream of M-TMCC structure you are
going to create is less than 48, a dummy transport stream(s) is(are) inserted
so that the number of slots reached to 48. The transport stream thus inserted
has the ID value set in the OPTION dialog box (See Figure C-4 on page
C-7) and TS8PSK is used as the modulation system.

This mode allows you to create a transport stream of M-TMCC structure from a
transport stream. In this mode, two Remux functions are simultaneously
executed: the Make S-TMCC TS and the ReMux to M-TMCC TS from
S-TMCC TS mode.

This subsection describes the procedure to create a transport stream of M-TMCC
structure from a transport stream.

1. Select New from the File pull-down menu or click the New button on the
toolbar to open the Select Remux Mode dialog box shown in Figure C-3 on
page C-5.

2. Select ReMux to M-TMCC  in the dialog box, and then click the OK  button
to open the edit window for the ReMux to M-TMCC TS mode shown in
Figure C-13.
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3. Select Add from the Edit  pull-down menu or clock the + (Add) button on
the toolbar to open the Open dialog box.

4. In the dialog box, select a transport stream file, and then click the Open
button to open the Edit TS Information  dialog box shown in Figure C-6 on
page C-10.

5. In the dialog box, set the parameters, and then click the OK  button. This will
display a transport stream icon in the window.


����������� �������� �������

6. With steps 6 through 9 on page C-14, multiplex the transport streams.
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7. With step 10 on page C-15, edit the TMCC information for M-TMCC.
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8. With steps 14 through 20 on page C-16 and C-17, multiplex the transport
stream of M-TMCC structure having different TMCC information.

�������  �������� ����� �� 
 �
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9. With steps 21 and 22 on page C-18, create a transport stream of M-TMCC
structure.
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This mode allows you to de-multiplex (separate) the original transport stream
from a transport stream of M-TMCC structure. The transport stream thus
de-multiplexed, in addition, is bit-rate converted to a packet form of 204 bytes.

This subsection describes the procedure to de-multiplex the original transport
stream from a transport stream of M-TMCC structure.

1. Select DeMux from the ReMux pull-down menu or click the DeMux
M-TMCC TS  button on the toolbar to open the Open dialog box.

2. In the dialog box, select a transport stream file of M-TMCC structure, and
then click the Open button to open the editing window for the DeMux
M-TMCC TS mode shown in Figure C-14.


����� ������	������ ������ ��� ��� ����� ����� � ����

����. If you select a transport stream file having no M-TMCC structure, an
error message appears.

3. Select Execute in the ReMux pull-down menu or click the � (Execute)
button to open the DEMUX dialog box shown in Figure C-15.
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In this dialog box, you can set the following parameters:

� Save to: Specifies the directory to which the de-multiplexed transport stream
to be saved.

� TS: Selects the transport stream(s) to be de-multiplexed. Click the check box
at the front of the file name to select the file to be de-multiplexed. When you
click the ... button at the right side of file name, the Save As... dialog box
appears, and you can specify a file name and save the file.

4. After you select the directory and transport stream(s), click the OK  button.
The transport stream(s) is(are) de-multiplexed and saved to the directory.
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This appendix provides procedures which verify the performance of the MPEG
generator. These tests comprise a valid confirmation of performance and
functionality when the following conditions are met:

� The MPEG generator must be operating in an environment that is within the
operating limits described in Table A-4 on page A-8.

� The MPEG generator and test equipment must have had a warm-up period of
at least 20 minutes.

��!����� ��� ��� ������ ���!����

Table D-1 lists the test equipment required to perform all of the performance
verification procedures. The table identifies examples of recommended
equipment and lists the required precision where applicable. If you substitute
other test equipment for the examples listed, the equipment must meet or exceed
the listed tolerances.
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The MPEG generator is shipped from the factory with sample MPEG test files
loaded on the hard disk. Two of these files are required to perform the perfor-
mance verification procedures. Table D-2 lists the required test files and the
performance verification tests that require these files.
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The following conventions are used in the performance verification procedures:

� Each test lists the characteristic that is being tested and the equipment
required to perform the test.

� Each test contains complete setup instructions, which allows you to perform
each test individually or in order.

� The equipment connection illustrations are specific to the recommended
equipment (equipment nomenclature is labeled). If you are using substitute
equipment, the location of your signal connections may vary from those in
the illustrations.

����. Before you perform the performance verification procedures, be sure that
the MPEG generator is operating in an environment that is within the operating
limits described in Table A-4 on page A-8.

In addition, the MPEG generator and the test equipment must be warmed up for
at least 20 minutes to ensure accurate test results.

The performance verification procedures appear in the following order:

1. Internal clock frequency

2. ASI output

3. SSI output

4. Parallel output

5. Serial output

6. External clock input

7. External reference input
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This test verifies the frequency of the MPEG generator’s internal clock. The
following equipment and MPEG test signal is required for this test:

� Frequency counter

� Probe

� test64.trp MPEG test signal

Perform the following procedure to verify the internal clock frequency of the
MPEG generator:

1. Connect the probe to the input of the frequency counter, and then attach the
probe tip to pin 1 of the ECL/TTL/LVDS OUT connector on the MPEG
generator as shown in Figure D-2.

2. Set the frequency counter to the frequency measurement mode (if necessary).
and then set the Gate Time to > 0.2 s.
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3. Open the test64.trp file on the MPEG generator.

a. Select Open TS File... from the FILE  pull-down menu.

b. In the resulting Select TS File dialog box, select the test64.trp file, and
then press the OK  bezel button.

4. Press the START/STOP button on the MPEG generator to start the signal
output of the test64.trp file.

5. Verify that the following LEDs on the MPEG generator’s front panel are
illuminated: PLL, BUFFER, and HDD.

6. Set the frequency counter to trigger on the input, and then confirm that the
displayed frequency is within the range of 7.999992 MHz to 8.000008 MHz.

7. Press the START/STOP button on the MPEG generator to stop the signal
output, and then remove the probe tip from the ECL/TTL/LVDS OUT
connector.
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This test verifies that transport stream data is output correctly from the ASI OUT
connector on the MPEG generator. The following equipment and MPEG test
signal is required for this test:

� Oscilloscope

� MPEG test system

� 75 � BNC cable

� 75 � to 50 � minimum loss attenuator

� test64.trp MPEG test signal

Perform the following procedure to verify that transport stream data is output
correctly from the ASI OUT connector on the MPEG generator:

1. Connect the ASI OUT connector on the MPEG generator to the oscilloscope
CH1 input using a 75 � BNC cable and the 75 � to 50 � minimum loss
attenuator as shown in Figure D-3.

2. Set the oscilloscope controls as indicated below:

Displayed channel CH1. . . . . 
Vertical axis 200 mV/div. . . . . . . . . . 
Horizontal axis 5 ns/div. . . . . . . 
Horizontal position Center. . . . 
Record length 500. . . . . . . . 
Acquire mode Sample. . . . . . . . 
Acquire sequence RUN/STOP button only. . . . . 
Trigger mode Auto. . . . . . . . . 
Trigger level 0 V. . . . . . . . . 
Trigger source CH1. . . . . . . . 
Trigger position 50 %. . . . . . . 
Trigger slope Rising Edge. . . . . . . . . 
Trigger coupling DC. . . . . . 
Display style Dots. . . . . . . . . 
Input coupling DC. . . . . . . . 
Input impedance 50 �. . . . . . 
Measure Amplitude. . . . . . . . . . . . . 

3. Open the test64.trp file on the MPEG generator.

a. Select Open TS File... from the FILE  pull-down menu.

b. In the resulting Select TS File dialog box, select the test64.trp file, and
then press the OK  bezel button.

4. Press the START/STOP button on the MPEG generator to start the signal
output of the test64.trp file.
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5. Verify that the following LEDs on the MPEG generator’s front panel are
illuminated: PLL, BUFFER, and HDD.

6. Use the oscilloscope to measure that the signal amplitude is within the range
of 720 mV to 880 mV.

7. Disconnect the BNC cable from the 75 � to 50 � minimum loss attenuator
on the oscilloscope’s input, and then connect the BNC cable to the ASI IN
connector on the MPEG test system’s Real Time Analyzer as shown in
Figure D-4.

8. Double-click the Real Time Analyzer icon in the MPEG test system’s
Program Group window to start the application.

9. In the Real Time Analyzer window on the MPEG test system, select
Settings... from the Configuration  menu to open the Settings window.

10. In the Settings window, select Hardware Configuration  to open the
Hardware Configuration window.

11. In the Hardware Configuration window, click the Restore Defaults button,
click the Apply  button, and then select DVB-PI ASI  as the Input Type.

12. In the Settings window, select ETR290 to open the ETR290 configuration
window.

13. In the ETR290 window, click the Restore Defaults button, click the Apply
button, and then click OK  to close the Settings window.
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14. In the Real Time Analyzer window, click the Start Analysis toolbar button.

15. Verify that the Hierarchic view is displayed on the screen and that no error
messages appear. In addition, verify that the transmission rate is 64 Mbps
and that the transport stream packet size is 188 bytes.

16. In the Real Time Analyzer window, click the Stop Analysis toolbar button
to stop analysis.

17. Press the START/STOP button on the MPEG generator to stop the signal
output, and then remove the BNC cable from the ASI OUT connector.

This test verifies that transport stream data is output correctly from the SSI OUT
connector on the MPEG generator. The following equipment and MPEG test
signal is required for this test:

� Oscilloscope

� MPEG test system

� 75 � BNC cable

� Parallel interface cable

� 75 � to 50 � minimum loss attenuator

� test40.trp MPEG test signal

Perform the following procedure to verify that transport stream data is output
correctly from the SSI OUT connector on the MPEG generator:

1. Connect the SSI OUT connector on the MPEG generator to the oscilloscope
CH1 input using a 75 � BNC cable and the 75 � to 50 � minimum loss
attenuator as shown in Figure D-5.
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2. Set the oscilloscope controls as indicated below (only the horizontal axis
setting is different from the setup in the ASI Output test):

Displayed channel CH1. . . . . 
Vertical axis 200 mV/div. . . . . . . . . . 
Horizontal axis 10 ns/div. . . . . . . 
Horizontal position Center. . . . 
Record length 500. . . . . . . . 
Acquire mode Sample. . . . . . . . 
Acquire sequence RUN/STOP button only. . . . . 
Trigger mode Auto. . . . . . . . . 
Trigger level 0 V. . . . . . . . . 
Trigger source CH1. . . . . . . . 
Trigger position 50 %. . . . . . . 
Trigger slope Rising Edge. . . . . . . . . 
Trigger coupling DC. . . . . . 
Display style Dots. . . . . . . . . 
Input coupling DC. . . . . . . . 
Input impedance 50 �. . . . . . 
Measure Amplitude. . . . . . . . . . . . . 

3. Open the test40.trp file on the MPEG generator.

a. Select Open TS File... from the FILE  pull-down menu.

b. In the resulting Select TS File dialog box, select the test40.trp file, and
then press the OK  bezel button.

4. Press the START/STOP button on the MPEG generator to start the signal
output of the test40.trp file.

5. Verify that the following LEDs on the MPEG generator’s front panel are
illuminated: PLL, BUFFER, and HDD.

6. Use the oscilloscope to measure that the signal amplitude is within the range
of 720 mV to 880 mV.



Appendix D: Performance Verification

MTG100 & MTG300 MPEG Generator User Manual ���

7. Disconnect the BNC cable from the 75 � to 50 � minimum loss attenuator
on the oscilloscope’s input, and then connect the BNC cable to the SSI IN
connector on the MPEG test system’s Real Time Analyzer as shown in
Figure D-6.

8. Use the parallel interface cable to connect the SSI parallel output to the
Real Time Analyzer parallel input on the MPEG test system rear panel as
shown in Figure D-6.

9. Double-click the Real Time Analyzer icon in the MPEG test system’s
Program Group window to start the application.

10. In the Real Time Analyzer window on the MPEG test system, select
Settings... from the Configuration  menu to open the Settings window.

11. In the Settings window, select Hardware Configuration  to open the
Hardware Configuration window.

12. In the Hardware Configuration window, click the Restore Defaults button,
click the Apply  button, and then select DVB-PI SPI (LVDS//) or ECL/  as
the Input Type.

13. In the Settings window, select ETR290 to open the ETR290 configuration
window.

14. In the ETR290 window, click the Restore Defaults button, click the Apply
button, and then click OK  to close the Settings window.

15. In the Real Time Analyzer window, click the Start Analysis toolbar button.

16. Verify that the Hierarchic view is displayed on the screen and that no error
messages appear. In addition, verify that the transmission rate is 40 Mbps
and that the transport stream packet size is 188 bytes.
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17. In the Real Time Analyzer window, click the Stop Analysis toolbar button
to stop analysis.

18. Press the START/STOP button on the MPEG generator to stop the signal
output, and then remove the BNC cable from the SSI OUT connector.

This test confirms that transport stream data is output correctly in parallel format
from the ECL/TTL/LVDS OUT connector on the MPEG generator. The
following equipment and MPEG test signal is required for this test:

� MPEG test system

� Parallel interface cable

� test64.trp MPEG test signal

Perform the following procedure to verify that transport stream data in parallel
format is output correctly from the ECL/TTL/LVDS OUT connector on the
MPEG generator:

1. Use the parallel interface cable to connect the ECL/TTL/LVDS OUT
connector on the MPEG generator to the LVDS/ECL/RS422 Level In
connector on the MPEG test system rear panel as shown in Figure D-7.

2. Open the test64.trp file on the MPEG generator.

a. Select Open TS File... from the FILE  pull-down menu.

b. In the resulting Select TS File dialog box, select the test64.trp file, and
then press the OK  bezel button.

3. Select Level : ECL from the OUTPUT menu on the MPEG generator, and
then press the OK  bezel button.

4. Select Interface : Parallel from the OUTPUT menu on the MPEG
generator, and then press the OK  bezel button.

5. Press the START/STOP button on the MPEG generator to start the signal
output of the test64.trp file.

6. Verify that the following LEDs on the MPEG generator’s front panel are
illuminated: PLL, BUFFER, and HDD.
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7. Double-click the Real Time Analyzer icon in the MPEG test system’s
Program Group window to start the application.

8. In the Real Time Analyzer window on the MPEG test system, select
Settings... from the Configuration  menu to open the Settings window.

9. In the Settings window, select Hardware Configuration  to open the
Hardware Configuration window.

10. In the Hardware Configuration window, click the Restore Defaults button,
click the Apply  button, and then select DVB-PI SPI (LVDS//) or ECL//  as
the Input Type.

11. In the Settings window, select ETR290 to open the ETR290 configuration
window.

12. In the ETR290 window, click the Restore Defaults button, click the Apply
button, and then click OK  to close the Settings window.

13. In the Real Time Analyzer window, click the Start Analysis toolbar button.

14. Verify that the Hierarchic view is displayed on the screen and that no error
messages appear. In addition, verify that the transmission rate is 64 Mbps
and that the transport stream packet size is 188 bytes.

15. In the Real Time Analyzer window, click the Stop Analysis toolbar button
to stop analysis.

16. Press the START/STOP button on the MPEG generator to stop the
signal output.
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This test confirms that transport stream data is output correctly in serial format
from the ECL/TTL/LVDS OUT connector on the MPEG generator. The
following equipment and MPEG test signal is required for this test:

� MPEG test system

� Parallel interface cable

� test64.trp MPEG test signal

Perform the following procedure to verify that transport stream data in parallel
format is output correctly from the ECL/TTL/LVDS OUT connector on the
MPEG generator:

1. Use the parallel interface cable to connect the ECL/TTL/LVDS OUT
connector on the MPEG generator to the ECL PARALLEL/SERIAL I/O
connector on the MPEG test system rear panel as shown in Figure D-8.

2. Open the test64.trp file on the MPEG generator.

a. Select Open TS File... from the FILE  pull-down menu.

b. In the resulting Select TS File dialog box, select the test64.trp file, and
then press the OK  bezel button.

3. Select Level : ECL from the OUTPUT menu on the MPEG generator, and
then press the OK  bezel button.

4. Select Interface : Serial from the OUTPUT menu on the MPEG generator,
and then press the OK  bezel button.

5. Press the START/STOP button on the MPEG generator to start the signal
output of the test64.trp file.

6. Verify that the following LEDs on the MPEG generator’s front panel are
illuminated: PLL, BUFFER, and HDD.
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7. Double-click the Data Store Administrator icon in the MPEG test system’s
Program Group window to start the application.

8. In the Data Store Administrator window, click the A (acquisition) command
button to open the Acquisition settings window.

9. In the Acquisition settings window, enter the following selections:

Board File test.trp (or unique file name). . . . . . . . . . . . . 
Partition Single shot (this selection appears if the hard. . . . . . . . . . . . . . 

drive of the MPEG test system is partitioned)
Size 10,000,000 (bytes). . . . . . . . . . . . . . . . . . 
Synchronization Lock Psync. . . . 
Port Serial ECL. . . . . . . . . . . . . . . . . . 
MSB First box Check (this selection appears after the port is. . . . . . . . . 

set to Serial ECL)

10. In the Acquisition settings window, click Start to start the acquisition.

11. Click OK  after the “Transfer is finished” message appears.

12. Select Exit/Quit  from File menu or click the close box in the upper-right
corner of the application window to exit the Data Store Administrator
application.

13. Double-click the Deferred Time Analyzer icon in the MPEG test system’s
Program Group window to start the application.

14. In the Deferred Time Analyzer window, select Open from the File menu or
click the Open command button in the upper toolbar to open the Open
dialog box.

15. Select the C:\Carb0\mono\test.trp (or your unique file name) file in the
Open dialog box, and then click Open to open the test.trp file.

16. In the Deferred Time Analyzer window, select Consistency Check from the
Analysis menu to check for consistency within the stream file.

17. Verify that the No Error Found  dialog box appears after the stream file is
checked by the Deferred Time Analyzer application.

18. Press the START/STOP button on the MPEG generator to stop the signal
output, and then remove the parallel interface cable from the rear panel.
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This test confirms that the external clock input (ECL CONTROL input) on the
MPEG generator is functioning correctly. The following equipment and MPEG
test signal is required for this test:

� MPEG test system

� 75 � BNC cable

� Custom 9-pin to 25-pin, D-type interface cable

� test40.trp MPEG test signal

Perform the following procedure to verify that the external clock input
(ECL CONTROL input) on the MPEG generator is functioning correctly:

1. Use the 75 � BNC cable to connect the ASI OUT connector on the MPEG
generator to the ASI IN connector on the rear panel of the MPEG test system
as shown in Figure D-9.

2. Use the custom interface cable (see Figure D-1 on page D-2) to connect
the ECL CONTROL connector on the MPEG generator to the ECL
PARALLEL/SERIAL I/O connector on the MPEG test system rear panel as
shown in Figure D-9.

3. Open the test40.trp file on the MPEG generator.

a. Select Open TS File... from the FILE  pull-down menu.

b. In the resulting Select TS File dialog box, select the test40.trp file, and
then press the OK  bezel button.
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4. Select Clock... from the OUTPUT menu on the MPEG generator to open
the Clock dialog box.

5. Select EXT CLOCK  in the Clock dialog box, and then press the OK  bezel
button.

6. Select Interface : Serial from the OUTPUT menu on the MPEG generator,
and then press the OK  bezel button.

7. Double-click the Data Store Administrator icon in the MPEG test system’s
Program Group window to start the application.

8. In the Data Store Administrator window, select any file from the File
information list, and then right-click to open the shortcut menu.

9. Click Generation to open the Generation settings window.

10. In the Generation settings window, make the following selections:

Port Serial ECL. . . . . . . . . . . . 
Frequency 40,000,000. . . . . . . 
Loop Check (select). . . . . . . . . . . 

11. In the Generation settings window, click Start to begin signal generation.

12. Press the START/STOP button on the MPEG generator to start the signal
output of the test40.trp file.

13. Verify that the following LEDs on the MPEG generator’s front panel are
illuminated: PLL, BUFFER, EXT, and HDD.

14. Double-click the Real Time Analyzer icon in the MPEG test system’s
Program Group window to start the application.

15. In the Real Time Analyzer window on the MPEG test system, select
Settings... from the Configuration  menu to open the Settings window.

16. In the Settings window, select Hardware Configuration  to open the
Hardware Configuration window.

17. In the Hardware Configuration window, click the Restore Defaults button,
click the Apply  button, and then select DVB-PI ASI  as the Input Type.

18. In the Settings window, select ETR290 to open the ETR290 configuration
window.

19. In the ETR290 window, click the Restore Defaults button, click the Apply
button, and then click OK  to close the Settings window.
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20. In the Real Time Analyzer window, click the Start Analysis toolbar button.

21. Verify that the Hierarchic view is displayed on the screen and that no error
messages appear. In addition, verify that the transmission rate is 40 Mbps
and that the transport stream packet size is 188 bytes.

22. Select Interrupt transfer  from the Acq/Gen menu in the Data Store
Administrator window stop the signal generation.

23. In the Real Time Analyzer window, click the Stop Analysis toolbar button
to stop analysis.

24. Press the START/STOP button on the MPEG generator to stop the
signal output.

This test confirms that the EXT 27 MHz REFERENCE IN input on the MPEG
generator is functioning correctly. The following equipment and MPEG test
signal is required for this test:

� MPEG test system

� Signal generator

� 75 � BNC cable

� 50 � BNC cable

� N-to-BNC adapter

� test64.trp MPEG test signal

Perform the following procedure to verify that the EXT 27 MHz REFERENCE
IN input on the MPEG generator is functioning correctly:

1. Use the 75 � BNC cable to connect the ASI OUT connector on the MPEG
generator to the ASI IN connector on the rear panel of the MPEG test system
as shown in Figure D-10.

2. Use the 50 � BNC cable and the N-to-BNC adapter to connect the
EXT 27 MHz REFERENCE IN connector on the MPEG generator to the
OUTPUT connector on the signal generator as shown in Figure D-10.

3. Set the signal generator output for a 27.0000 MHz, 0.0 dBm signal.

4. Open the test64.trp file on the MPEG generator.

a. Select Open TS File... from the FILE  pull-down menu.

b. In the resulting Select TS File dialog box, select the test64.trp file, and
then press the OK  bezel button.
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5. Select Clock... from the OUTPUT menu on the MPEG generator to open
the Clock dialog box.

6. Select EXT REF in the Clock dialog box, and then press the OK  bezel
button.

7. Press the START/STOP button on the MPEG generator to start the signal
output of the test64.trp file.

8. Verify that the following LEDs on the MPEG generator’s front panel are
illuminated: PLL, BUFFER, EXT, and HDD.

9. Double-click the Real Time Analyzer icon in the MPEG test system’s
Program Group window to start the application.

10. In the Real Time Analyzer window on the MPEG test system, select
Settings... from the Configuration  menu to open the Settings window.

11. In the Settings window, select Hardware Configuration  to open the
Hardware Configuration window.

12. In the Hardware Configuration window, click the Restore Defaults button,
click the Apply  button, and then select DVB-PI ASI  as the Input Type.

13. In the Settings window, select ETR290 to open the ETR290 configuration
window.

14. In the ETR290 window, click the Restore Defaults button, click the Apply
button, and then click OK  to close the Settings window.
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15. In the Real Time Analyzer window, click the Start Analysis toolbar button.

16. Verify that the Hierarchic view is displayed on the screen and that no error
messages appear. In addition, verify that the transmission rate is 64 Mbps
and that the transport stream packet size is 188 bytes.

17. In the Real Time Analyzer window, click the Stop Analysis toolbar button
to stop analysis.

18. Press the START/STOP button on the MPEG generator to stop the
signal output.
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Inspect and clean the instrument as often as your operating conditions require.
The collection of dirt can cause instrument overheating and operational failure.
Dirt acts as an insulating blanket, preventing efficient heat dissipation. Dirt also
provides an electrical conduction path that can cause an instrument failure,
especially under high-humidity conditions.

�������� Avoid the use of chemical cleaning agents that might damage the
plastics used in this instrument. Use only deionized water when cleaning the
front-panel controls. Use a 75% ethyl alcohol solution as a cleaner and rinse
with deionized water.

Avoid the use of high-pressure compressed air when cleaning dust from the
interior of this instrument. High-pressure air can cause Electro Static Discharge
(ESD). Instead, use low-pressure compressed air (about 9 psi).

�������� ����������

Using Table E-1 as a guide, inspect the outside of the instrument for damage,
wear, and missing parts. You should thoroughly check instruments that appear to
have been dropped or otherwise abused to verify correct operation and perfor-
mance. Immediately repair defects that could cause personal injury or lead to
further damage to the instrument.
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Perform the following steps when you clean the exterior of the instrument:

�������� To avoid injury or death, unplug the power cord from line voltage
before cleaning the instrument. Avoid getting moisture inside the instrument
during external cleaning. Use only enough liquid to dampen the cleaning cloth.

1. Remove loose dust on the outside of the instrument with a lint-free cloth.

2. Remove remaining dirt with a lint-free cloth dampened with a general pur-
pose detergent-and-water solution. Do not use abrasive cleaners.

3. Clean the monitor screen with a lint-free cloth dampened with a gentle,
general purpose detergent-and-water solution.
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ACTS (Advanced Communications Technologies and Services)
A set of telecommunication research projects financed by the European
Union.

ARIB
Association of Radio Industries and Businesses.

ATSC
Advanced Television Systems Committee.

BAT (Bouquet Association Table)
One of the tables defined by DVB-SI. The BAT provides information
regarding bouquets (collections of services marketed as a single entity).
DVB only.

CAT (Conditional Access Table)
One of the PSI tables described by the MPEG-2 standard. The CAT provides
the association between one or more CA systems, their EMM (Entitlement
Management Message) streams, and any special parameters associated
with them.

CRC (Cyclic Redundancy Check)
One of the fields described in the MPEG-2 standard. CRC is used to verify
the correctness of data in PSI and SI tables.

Defragmentation
The process of rewriting parts of a file to contiguous sectors on a hard disk
to increase the speed of access and retrieval. When files are updated, the
computer tends to save these updates on the largest continuous space on the
hard disk, which is often on a different sector than the other parts of the file.
When files are thus “fragmented,” the computer must search the hard disk
each time the file is accessed to find all of the file’s parts, which slows down
response time.

DVB (Digital Video Broadcast)
A project group of the European Broadcasting Union (EBU).

DVB-MG
Digital Video Broadcasting - Measurement Guidelines.

DVB-SI (Digital Video Broadcast Service Information)
The DVB-SI adds the information that enables DVB IRDs to automatically
tune to particular services and allows services to be grouped into categories
with relevant schedule information. It has several tables, including: NIT,
SDT, BAT, and EIT. (NIT is also required for MPEG-2.)
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DTS (Decoding Time-Stamp)
One of the fields described in the MPEG-2 standard. The DTS may be
present in a PES packet header that indicates the time that an access unit is
decoded in the T-STD.

ECM  (Entitlement Control Message)
Private conditional access information that specifies control words and
possibly other, typically stream-specific, scrambling and/or control
parameters.

EISA (Extended Industry Standard Architecture)
The PC bus used to communicate with the CARB and PIA boards.

EIT (Event Information Table)
One of the tables defined by DVB-SI. The EIT contains data concerning
events (a grouping of elementary broadcast data streams with a defined start
and end time belonging to a common service) and programs (a concatenation
of one or more events under the control of a broadcaster, such as event name,
start time, and duration).

EMM (Entitlement Management Message)
Private conditional access information that identifies the authorization levels
or the services of specific decoders.

ETS (European Telecommunication Standard)
One of the types of documents released by ETSI.

ETSI
European Telecommunications Standards Institute.

ETR (ETSI Technical Report)
One of the types of documents released by ETSI.

IRD (Integrated Receiver / Decoder)
A receiving decoder that can automatically configure itself using the
MPEG-2 Program Specific Information (PSI).

ISO (International Standard Organization)
Organization responsible for establishing standards at the world-wide level.

MPEG-2
A standard developed by MPEG (Moving Picture Experts Group) for the
compression of digital video.
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NIT (Network Information Table)
One of the PSI tables described by the MPEG-2 standard and also one of the
tables defined by DVB-SI. The NIT conveys information relating to the
physical organization of the multiplex; that is, transport streams carried via a
given network and the characteristics of the network itself. Transport streams
are identified by the combination of an original network ID and a transport
stream ID in the NIT.

PAT (Program Association Table)
One of the PSI tables described in the MPEG-2 standard. The PAT provides
information about the structure of a transport stream.

PCR (Program Clock Reference)
One of the fields defined in the MPEG-2 standard. A time stamp in the
transport stream from which decoder timing is derived.

PES (Packetized Elementary Stream)
A structure defined in the MPEG-2 standard used to carry elementary
stream data.

PID (Packet IDentifier)
One of the fields described in the MPEG-2 standard. A unique integer value
used to identify elementary streams of a program in a single or multipro-
gram TS.

PMT (Program Map Table)
One of the PSI tables described by the MPEG-2 standard. The PMT
identifies and indicates the locations of the streams that make up each
service and the location of the Program Clock Reference (PCR) fields for a
service. This table is transmitted in sections.

PSI (Program Specific Information)
A set of tables described by the MPEG-2 standard. The PSI contains all of
the tables that define the MPEG-2 transport stream. It consists of the PAT,
PMT, CAT, and NIT tables. (NIT is also used for DVB-SI.)

PSIP
Program and System Information Protocol.

PTS (Presentation Time Stamp)
One of the fields described in the MPEG-2 standard. The PTS may be
present in a PES packet header that indicates the time that a presentation unit
is presented in the T-STD.

RST (Running Status Table)
One of the tables defined by DVB-SI. The RST gives a quick updating
mechanism for the status information carried in the EIT.
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SDT (Service Description Table)
One of the tables defined by DVB-SI. The SDT contains data describing the
services in the system. Examples include: names of services and the
service provider.

SI (Service Information)
Set of tables defined by DVB-SI. The SI provides information on services
and events carried by different Multiplexes, and even other networks. SI is
structured as six tables (PAT, NIT, CAT, SDT, EIT, and BAT). The applica-
tions are only concerned with NIT, BAT, SDT, and EIT.

ST (Stuffing Table)
One of the tables defined by DVB-SI. The ST provides stuffing sections.

TDT (Time & Date Table) 
One of the tables defined by DVB-SI. The TDT carries the current time and
date information.

TOT (Time Offset Table)
One of the tables defined by DVB-SI. The TOT gives information about a
local time offset in a given area.

TS (Transport Stream)
A bit stream that contains 0 or more elementary streams combined in a
manner that conforms to the MPEG-2 standard.

T-STD (Transport Stream System Target Decoder)
Described by the MPEG-2 standard, the T-STD is a hypothetical reference
model of a decoding process used to define the semantics of a TS.
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AC line voltage requirements, 1-6
Accessories, 1-3
Add TMCC dialog box (ReMux), C-16
Adding jitter to PCRs (MTG300 only), 3-89
Address, Tektronix, xiv
ADFERR icon, 3-65
An example preset file, 3-98
Arrow buttons, 2-4
ASI Out connector, 2-5
ASI output, Performance verification, D-5
AUDIO icon, 3-54
AUDIO_AAC icon, 3-56
AUDIO_AC3 icon, 3-56
Auto Update mode, 2-16

�

Basic menu operation, 2-9
BAT icon, 3-66
Bezel buttons, 2-2, 2-11
Bezel menu, 2-6, 2-11, 3-1

display states, 2-11
Bit rate indicator, 2-8
BS key, 2-3
Buffer indicator, 2-3

�

CAT icon, 3-46
Certifications and compliances, A-9
CETT icon, 3-72
Changing the PCR interval tutorial (MTG300 only),

2-20
Cleaning the instrument exterior, E-2
Clock dialog box, 3-7
Clock source indicator, 2-8
CONFIG pull-down menu, 3-9
Connecting a PC to the MPEG generator, B-4
Contacting Tektronix, xiv
Contents of the preset file, 3-95
Copying a file, 3-100
Creating a new folder, 3-99
Crossover Ethernet cable, B-4
CVCT icon, 3-72

�

DATA icon, 3-57
DATA_SECT icon, 3-58
Daylight Savings time, 3-16, 3-17, 3-74, 3-79
DCT icon, 3-66
Deleting a file, 3-102
Deleting a folder, 3-102
DEMUX dialog box (ReMux), C-21
Dialog boxes

Add TMCC (ReMux), C-16
Clock, 3-7
DEMUX (ReMux), C-21
Drive, 3-23
DTS Stress, 3-54
Edit TMCC Information (ReMux), C-12, C-15
Edit TS Information (ReMux), C-10
File copy, 3-101
Input new folder name, 3-99
Input Preset Filename, 3-96
Insert File (MTG Comm+), B-21
Insertion Setup, 2-24, 3-12, 3-87
Network, 3-20, B-5
OPTION (ReMux), C-7
PAT Interval, 3-41
PCR Interval, 2-21, 3-50
PCR Start Value, 3-11
PCR Stress, 3-51, 3-89
PMT Interval, 3-49
Preset File (MTG Comm+), B-22
Random Error Stress, 3-39
Rename file, 3-102
Replace Setup, 3-42, 3-82
Select Drive, 3-100
Select Insert File, 2-23, 3-86
Select Preset File, 3-97
Select Remux Mode (ReMux), C-5
Select Replace File, 3-82
Select TS File, 1-10, 2-18, 3-5
Set MTG Host Name (MTG Comm+), B-6
Set Options (MTG Comm+), B-19
Set Psync (MTG Comm+), B-16
Start/End Packet, 3-10, 3-38
Stress SI, 3-61
STT Item, 3-16, 3-18
System, 3-23
TOT Item, 3-15
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TS Head Stress, 3-36
User Check (MTG Comm+), B-13

Display, 2-2
Display elements, 2-6
DIT icon, 3-66
DLT icon, 3-66
Downloading a file to the MPEG generator, B-20
Drive dialog box, 3-23
DSM_CC icon, 3-59
DTS Stress dialog box, 3-54

�

EC declaration of conformity, A-9
ECL Control connector, 2-5
ECL/TTL/LVDS Out connector, 2-5
ECM icon, 3-60
Edit menu (ReMux), C-6
Edit TMCC Information dialog box (ReMux), C-12,

C-15
Edit TS Information dialog box (ReMux), C-10
EETT icon, 3-72
EIT icon, 3-66, 3-72
Elapsed time display, 2-6
Electrical characteristics, A-4
EMM icon, 3-62
ENTER key, 2-3
Environmental characteristics, A-8
Environmental operating requirements, 1-6
Ethernet connector, 2-5
Ethernet parameters, B-5, B-6
Exiting the MTG Comm+ application, B-8
EXT indicator, 2-3
Exterior cleaning, E-2
Exterior inspection, E-1
External 27 MHz Reference In connector, 2-5
External clock input, Performance verification, D-14
External reference input, Performance verification, D-16

�

FCC compliance, A-9
File copy dialog box, 3-101
File menu (MTG Comm+), B-12
File menu (ReMux), C-5
FILE pull-down menu, 3-4
File transfers, B-1
Floppy disk drive, 2-1
Front panel controls, 2-1
Functional characteristics, A-2
Functional check procedure, 1-10

�

GARBAGE icon, 3-66
General characteristics, A-1
GHOST icon, 3-63
Glossary, Glossary–1
GPS/UTC offset, 3-16, 3-74

�

HDD indicator, 2-3
Help menu (MTG Comm+), B-19
Help menu (ReMux), C-8
Hexadecimal keypad, 2-3, 2-12
Hierarchy display, 2-6, 3-25, 3-26
Hierarchy display icons, 3-27, 3-28, 3-29, 3-30, 3-32

�

Icon cursor, 2-6, 2-21, 3-25
Icons, hierarchic view, 3-26
Initial product inspection, 1-4
Input new folder name dialog box, 3-99
Input Preset Filename dialog box, 3-96
INS_SI icons, 3-76
INS_STT icon, 3-79
INS_TDT icon, 3-78
INS_TOT icon, 3-78
INS_TS icon, 3-77
Insert File dialog box (MTG Comm+), B-21
Inserting an EIT tutorial (MTG300 only), 2-23
Inserting section data, 3-86
Insertion Setup dialog box, 2-24, 3-12, 3-87
Inspection and cleaning, E-1
Installation, 1-6
Installing MTG Comm+, B-2
Internal clock frequency, Performance verification, D-4
Interval jitter function, 3-90

Deviation mode, 3-91
Period mode, 3-90

ITT icon, 3-66

�

Keyboard connector, 2-5
Knob icon, 2-8, 2-10, 2-13

	

LCD display, 2-2
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LED indicators, 2-2
Left control button, 2-3
LIT icon, 3-66
Loading a preset file, 3-97
Loop mode indicator, 2-8
Loop modes, 2-15

�

Mechanical characteristics, A-7
Menu bar, 2-6
MENU button, 2-2
Menu system, 2-9
MGT icon, 3-70
MTG Comm+ application, B-1
MTG Comm+ operating basics, B-7
MTG Comm+ tutorials, B-20
M-TMCC icon, 3-75
Multi section mode, 3-83

�

Network dialog box, 3-20, B-5
NIT icon, 3-45
No Update mode, 2-15
Non TS icon, 3-76
NULL icon, 3-65
Numeric input, 2-12
Numeric input using the hexadecimal keypad, 2-12
Numeric input using the rotary knob, 2-13

�

ON/STBY power switch, 2-1
OPTION dialog box (ReMux), C-7
Optional accessories, 1-3
Options

Option 1R (Rackmounting), 1-3
Option D1 (Calibration Test Data Report), 1-3
power cords, 1-5

Output loop modes, 2-15, 3-1
OUTPUT pull-down menu, 3-6
Output status indicator, 2-8
Outputting a transport stream tutorial, 2-18

�

Packet size indicator, 2-8
Parallel output, Performance verification, D-10
PAT icon, 3-40
PAT Interval dialog box, 3-41

PC system requirements for MTG Comm+, B-1
PCAT icon, 3-66
PCR icon, 3-49
PCR Interval dialog box, 2-21, 3-50
PCR Start Value dialog box, 3-11
PCR Stress dialog box, 3-51, 3-89
Performance conditions, A-1
Performance verification

ASI output, D-5
External clock input, D-14
External reference input, D-16
Internal clock frequency, D-4
Parallel output, D-10
Serial output, D-12
SSI output, D-7

Performance verification procedures, D-3
Phone number, Tektronix, xiv
PIT icon, 3-70
PLL indicator, 2-3
PMT icon, 3-48
PMT Interval dialog box, 3-49
Pop-up message box, 2-14
Position indicator, 2-8
Power connector, 2-6
Power cord requirements, 1-7
Power on procedure, 1-7
Preset File dialog box (MTG Comm+), B-22
PRI icon, 3-64
Principle Power switch, 2-5
Principle power switch, 1-7
Product description, 1-1
Product support, contact information, xiv
Pull-down menus, 2-7, 2-9, 3-3

CONFIG, 3-9
display states, 2-10
FILE, 3-4
OUTPUT, 3-6
UTILITY, 3-19

�

Random Error Stress dialog box, 3-39
Rear panel, 2-4
Related manuals, xiii
Remote menu (MTG Comm+), B-18
ReMux application, C-1
ReMux menu (ReMux), C-6, C-7
ReMux tutorials, C-8
Rename file dialog box, 3-102
Renaming a file name, 3-102
Renaming a folder name, 3-102
Repackaging for shipment, 1-9
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Replace Setup dialog box, 3-42, 3-82
Replacement modes, 3-84
Replacing section data (MTG300 only), 3-81
Right control button, 2-3
Rotary knob, 2-4, 2-13
RRT icon, 3-72
RST icon, 3-66

�

Safety compliances, A-9
Saving a preset file, 3-96
Scroll bar, 2-6
SDT icon, 3-66
SDTT icon, 3-66
Section End replacement mode, 3-84
Section modes, 3-83
Select Drive dialog box, 3-100
Select Insert File dialog box, 2-23, 3-86
Select Preset File dialog box, 3-97
Select Remux Mode dialog box (ReMux), C-5
Select Replace File dialog box, 3-82
Select TS File dialog box, 1-10, 2-18, 3-5
Serial connector, 2-5
Serial output

Configuring, 3-6
Performance verification, D-12

Service support, contact information, xiv
Set MTG Host Name dialog box (MTG Comm+), B-6
Set Options dialog box (MTG Comm+), B-19
Set Psync dialog box (MTG Comm+), B-16
Setting Ethernet parameters, B-4
Setting values with the rotary knob, 2-13
Single section mode, 3-83
SIT icon, 3-66
Specifications, A-1
SSI Out connector, 2-5
SSI output, Performance verification, D-7
ST icon, 3-66
Standard accessories, 1-3
Standard indicator, 2-8
Standby power switch, 1-7, 2-1
Start/End Packet dialog box, 3-10, 3-38
START/STOP button, 2-2
Starting the MTG Comm+ application, B-8
Starting the ReMux application, C-1
Startup diagnostics, 1-9
Status bar, 2-8

S-TMCC icon, 3-75
Stress mode (MTG300 only), 2-16
Stress SI dialog box, 3-61
STT icon, 3-74
STT Item dialog box, 3-16, 3-18
System dialog box, 3-23

�

TDT icon, 3-68
TDT/TOT/STT time display, 2-6
Technical support, contact information, xiv
Text input, 2-13
Timing replacement mode, 3-85
TOT icon, 3-68
TOT Item dialog box, 3-15
Transport stream icon, 3-34
TS Head Stress dialog box, 3-36
TSDT icon, 3-44
Tutorials

changing the PCR interval (MTG300 only), 2-20
inserting an EIT (MTG300 only), 2-23
MPEG generator, 2-17
MTG Comm+, B-20
outputting a transport stream, 2-18
ReMux, C-8

TVCT icon, 3-72

�

Uploading a file to a PC, B-22
URL, Tektronix, xiv
User Check dialog box (MTG Comm+), B-13
Utility menu (MTG Comm+), B-18
UTILITY pull-down menu, 3-19

�

Value jitter function, 3-92
VGA connector, 2-5
VIDEO icon, 3-53
View menu (MTG Comm+), B-17
View menu (ReMux), C-8

�

Web site address, Tektronix, xiv
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